
INTRODUCTION TO INFORMATION 

TECHNOLOGY

- II B.Com

Dr P.V. Praveen Sundar,

Assistant Professor,

Department of Computer Science

Adhiparasakthi College of Arts & Science,

Kalavai.

03-08-2020



Introduction
2

 Information Technology (IT) is the use of any

computers, storage, networking and other physical

devices, infrastructure and processes to create,

process, store, secure and exchange all forms of

electronic data. The commercial use of IT

encompasses both computer technology and

telephony.



Introduction
3

 Computer Stands for Common Oriented Machine

Particularly Used for Trade, Education and

Research.

 Computer can also be defined as Common

Operated Machine Particularly Used for Trade,

Education and Research.



Contd…
4

 Computer is an electronic device for storing and

processing data, typically in binary form, according

to instructions given to it in a variable program.

 A Computer is a machine that accepts data as input,

processes that data using programs, and outputs the

processed data as information.



Contd…
5

 Data – Data is defined as an unprocessed collection of raw facts,
suitable for communication and processing.

For Example, Praveen, CS Department, APCAS are data. This will not
give any meaningful data.

 Information is a collection of facts from which conclusions of facts
from which conclusions maybe drawn. In Simple words, data is the
raw facts that is processed to give meaningful , ordered or
structured information.

Example: Praveen from CS Department of APCAS. This information
conveys some meaning.
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 The conversion of data into information is called as
Data Processing.

 Computer data is considered as the information
processed or stored by a computer. This information
may be in the form of text documents, images, audio
clips, software programs, or other types of data.

 An Instruction is a group of bits that define operations
such as add, subtract, multiply, shift and compliment.



Contd…
7

 A Computer program is a collection of instructions

that can be executed by a computer to perform a

specific task.

 A computer program is usually written by a

computer programmer using a programming

language.
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 A Computer is an electronic device that takes raw

data(unprocessed) as an input from the user and

processes it under the control of a set of

instructions(called Program), produces a result

(output) and saves it for future use.



Data Representation
9

 Computer handles data in the form of ‘0’ and ‘1’s.

 Any kind of data like number, alphabet, special

character should be converted to ‘0’ or ‘1’ which

can be understood by the Computer. ‘0’ and ‘1’ that

the Computer can understand is called Machine

language.
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 A bit is the short form of Binary digit which can be 

‘0’ or ‘1’. It is the basic unit of data in computers.

 A nibble is a collection of 4 bits (Binary digits).

 A collection of 8 bits is called Byte.

 A byte is considered as the basic unit of measuring 

the memory size in the computer.
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 A collection of 1024 bytes is called Kilo Byte (KB).

 A collection of 1024 Kilo bytes is called Mega Byte 
(MB).

 A collection of 1024 mega bytes is called Giga 
Byte (GB).

 A collection of 1024 Giga bytes is called Terra 
Byte (TB).
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 A collection of 1024 Terra Bytes is called Peta Byte 

(PB).

 A collection of 1024 Peta bytes is called Exa Byte (EB).

 A collection of 1024 Exa bytes is called Zetta Byte (ZB).

 A collection of 1024 Zetta bytes is called Yotta Byte 

(YB).
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History of Computers
15

 The first generation of the computer used vacuum tubes
for the circuitry and the magnetic drums for the memory
and taking up the big rooms.

 A vacuum tube was a fragile glass device, which
filaments as a source of electronics and could control
and amplify electronic signals.

 It was the only high – speed electronic switching devices
available in those days.



First Generation: Vacuum Tubes (1940–1956)
16

 The first-generation computers were very expensive to
operate and uses a great amount of electricity and
produced a large amount of heat.

 The first generation of the computer relied on the
machine language. It can solve the one problem at a
time can’t do the multitasking work. The input was
based on the punched cards and the paper tape and
the output was displayed on the printouts.
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 Advantages

 Vacuum tubes were the only electronic component available during those days.

 Vacuum tube technology made possible to make electronic digital computers.

 Disadvantages

 The computers were very large in size.

 They consumed a large amount of energy.

 They heated very soon due to thousands of vacuum tubes.

 They were not very reliable.

 Air conditioning was required.
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 Constant maintenance was required.

 Non-portable.

 Costly commercial production.

 Limited commercial use.

 Very slow speed.

 Limited programming capabilities.

 Used machine language only.

 Used magnetic drums which provide very less data storage.

 Used punch cards for input.



Vacuum Tubes
19



Second Generation (1956-1964)
20

 John Bardeen, William Shockley, and Walter Brattain
invented a new electronic switching device called
transistors at Bell laboratories in 1947.

 Transistors were used in the second generation of the
computer and transistors replaced the vacuum tubes.

 Due to the transistor’s computer becomes smaller,
cheaper and faster. It is very reliable than the first
generation of the computer.
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 Transistors were also produced the large amount of
heat that subjected the computer to damage. But some
improvement was shown that in the second generation
of the computer.

 High-level programming languages were also
developed at the same time. The first computer of the
second generation was developed for the atomic
energy industry.



Advantages
22

✓ More reliable than the first generation.

✓ Good speed and can calculate the data in the microseconds.

✓ Also used assembly languages.

✓ Smaller in the size as compared to the first generation.

✓ Use less amount of energy.

✓ Portable

✓ Accuracy is improved than its predecessor.



Disadvantages
23

✓ Constant maintenance is required to work properly.

✓ Commercial production was very difficult.

✓ Still punched cards were used for input.

✓ The cooling system is required.

✓ More expensive and non-versatile.

✓ Used for specific purposes.



Transistors
24



Third Generation Computers (1965-1970)
25

 Third generation of computers are Integrated Circuits (IC)
which was founded by Jack St. Clair Kilby and Robert
Noyce in 1958.

 Integrated circuits are the circuits consisting of several
electronic components like transistors, capacitors, and
resistors.

 Transistors were placed on the silicon chips known as
semiconductors which increases the speed and efficiency of
the computer drastically.
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 A single IC chip may contain thousands of transistors.

 Instead of the punched cards and printouts, users
interacted with third generation computers through
keyboards and monitors and interfaced with an OS
(operating system), which allowed the device to run
many applications at one time.

 This generation of the computer is small, cheaper and
reliable than its predecessors.
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 Another salient feature of these computers was that
they were much more reliable and consumed far less
power.

 The input languages for such computers were COBOL,
FORTRAN-II up to FORTRAN-IV, PASCAL, ALGOL-68,
BASIC, etc. These languages were much better and
could represent more information.

 Consequently, more and more complex calculations are
possible.



Advantages
28

✓ Smaller in size as compared to previous generations.

✓ More reliable.

✓ Used less energy

✓ Produced less heat as compared to the previous two 

generations of computers.

✓ Better speed and could calculate data in nanoseconds.
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✓ Used fan for heat discharge to prevent damage.

✓ Maintenance cost was low because hardware failure is rare.

✓ Could be used for high-level languages.

✓ Versatile to an extent

✓ Less expensive

✓ Better accuracy

✓ Commercial production increased.

✓ Used mouse and keyboard for input.



Disadvantages
30

✓ Air conditioning was required.

✓ Highly sophisticated technology required for the 

manufacturing of IC chips



Integrated Circuits
31



Fourth Generation Computers (1975-Present)
32

 The fourth-generation computers started with the invention of
Microprocessor.

 The Microprocessor contains thousands of ICs.

 Ted Hoff produced the first microprocessor in 1971 for Intel. It was
known as Intel 4004.

 It greatly reduced the size of computer.

 The size of modern Microprocessors is usually one square inch.

 During the fourth generation, semiconductors memories replaced
magnetic core memories resulting in large random-access memories
with very fast access time.
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 On another side, Hard disks became cheaper, smaller, and
larger in capacity.

 On the software side, several new developments came to
match the new technologies of the fourth generation.

 This generation of computers had the first “supercomputers”
that could perform many calculations accurately.

 The computer languages like languages like C, C+, C++,
DBASE etc. were the input for these computers.



34

 Advantages

 More powerful and reliable than previous generations.

 Smaller in size

 Fast processing power with less power consumption

 Fan for heat discharging and thus to keep cold.

 No air conditioning required.

 Cheapest among all generations

 All types of High-level languages can be used in this type of computers

 Disadvantages

 The latest technology is required for manufacturing of Microprocessors.



Micro Processor
35
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Parts of Computer System
37

 Computer System is composed of Hardware, Software,
Memory and Users.

Hardware:

❖ Hardware consists of the mechanical parts that makeup the
computer as a machine.

❖ Those devices are required for input, output, store the data
and process the data.

❖ Such devices are keyboard, Mouse, Hard disk, CD Drive,
Printer, Mother board, ROM, RAM, etc.,



Software
38

 Software is a collection of data or computer instructions that
tell the computer how to work.

 Software comprises the entire set of programs, procedures,
and routines associated with the operation of a computer
system.

 A set of instructions that directs a computer's hardware to
perform a task is called a program, or software program.

 Examples of applications include Office suites, Database
programs, Web browsers, Word processors



Memory
39

 Computer memory is a device that is used to store data
or programs (sequences of instructions) on a temporary
or permanent basis.

 Computer memory is divided into Main (or Primary)
memory and Auxiliary (or secondary) memory.

 Main memory holds instructions and data when a
program is executing, while auxiliary memory holds
data and programs not currently in use and provides
long-term storage.



Main Memory 
40

❖ Main memory is accessible directly by the CPU.

❖ Primary memory holds only those data and instructions on
which the computer is currently working.

❖ It has a limited capacity and data is lost when power is
switched off.

❖ It is generally made up of semiconductor device.

❖ The data and instruction required to be processed resides in
the main memory.

❖ It is divided into four subcategories RAM, ROM, Cache and
Registers.



41



Characteristic of Primary Memory
42

❖ The computer can't run without primary memory

❖ It is known as the main memory.

❖ It is a working memory of the computer.

❖ Primary memory is faster comparing to secondary memory. 



Read Only Memory (ROM)
43

 ROM stands for Read only Memory

 ROM is non-volatile memory.

 The user cannot write data to the ROM without special
access.

 ROM is usually found as a chip(s) on the motherboard and is
used to store the Basic Input and Output System (BIOS) of
the computer along with other important information that is
needed to function.

 ROM was designed so that the BIOS could be accessed by
the computer without the need for other parts of hardware.
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Types of ROM
45

 Programmable Read Only memory (PROM)

 Erasable Programmable Read Only memory 

(EPROM).

 Electrically Erasable Programmable Read Only 

memory (EEPROM).



Programmable Read Only memory (PROM)
46

 PROM or Programmable ROM (Programmable Read-Only Memory)
is a read-only memory that can be modified only once by a user.

 The user buys a blank PROM and enters the desired contents using a
PROM program.

 Inside the PROM chip, there are small fuses which are burnt open
during programming.

 PROM was first developed by Wen Tsing Chow in 1956.

 An example of a PROM is a computer BIOS in early computers.

 Today, PROM in computers has been replaced by EEPROM.
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EPROM.
48

 EPROM (Erasable programmable read-only memory) that can be
erased and re-used. Erasure is caused by shining an intense
ultraviolet light through a window that is designed into the memory
chip.

 This type of memory you can rewrite data over the old data, but
you cannot keep the old data.

 So once you burn the new data into the ROM chip, the old data is
gone.

 EPROM ensures each process will be performed repeatedly and is
more expensive then PROM, the advantages over PROM is that is
capable of multiple updates.
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EEPROM
50

 EEPROM -Electrically Erasable Programmable ROM.

 It can be erased and reprogrammed about ten thousand
times.

 Both erasing and programming take about 4 to 10 ms
(millisecond).

 In EEPROM, any location can be selectively erased and
programmed.

 EEPROMs can be erased one byte at a time, rather than
erasing the entire chip. Hence, the process of
reprogramming is flexible but slow.
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Cache Memory
52

 CACHE is a hardware or software component that stores data so that future
requests for that data can be served faster; the data stored in a cache
might be the result of an earlier computation or a copy of data stored
elsewhere.

 Cache is used to store small bits of frequently accessed data from the RAM
so that the processor doesn't have to wait for the RAM to respond every
time it wants the same piece of information.

 Cache is volatile, like RAM, so it wipes clear whenever the computer gets
turned off.

• Cache memory lies on the path between the CPU and the main memory.

• It facilitates the transfer of data between the processor and the main 
memory at the speed which matches to the speed of the processor.
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54

 Processor registers are located inside the processor. 

 Each register typically holds a word of data (often 32 
or 64 bits). 

 CPU instructions instruct the arithmetic logic unit to 
perform various calculations or other operations on this 
data (or with the help of it). 

 Registers are the fastest of all forms of computer data 
storage.



Random Access Memory (RAM)
55

 RAM is a type of data storage used in computers, it
acts as a mediator between the CPU and the storage
device which helps speed up the computer.

 When the user try to access a piece of information, such
as opening an application, it gets moved from the hard
drive to the RAM.

 The CPU then reads from the RAM instead of the hard
drive as it can access the RAM and read from it much
faster than it can if the data was still on the hard drive.
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 RAM is of two types −
❖ Static RAM (SRAM)

❖ Dynamic RAM (DRAM)

 The word static indicates that the memory retains its contents as long
as power is being supplied. However, data is lost when the power
gets down due to volatile nature.

 DRAM must be continually refreshed in order to maintain the data.
This is done by placing the memory on a refresh circuit that rewrites
the data several hundred times per second. DRAM is used for most
system memory as it is cheap and small.



Characteristic of Static RAM
57

✓ Long life

✓ No need to refresh

✓ Faster

✓ Used as cache memory

✓ Large size

✓ Expensive

✓ High power consumption



Characteristics of Dynamic RAM
58

✓ Short data lifetime

✓ Needs to be refreshed continuously

✓ Slower as compared to SRAM

✓ Used as RAM

✓ Smaller in size

✓ Less expensive

✓ Less power consumption



Differences Between RAM and ROM
59

1. RAM is a temporary storage type of memory as data lasts
only till the time the power supply is on. On the contrary,
ROM is a permanent memory that retains the data for a
longer duration.

2. Random-access memory is volatile in nature. But read-only
memory is non-volatile in nature.

3. The operating speed of RAM is faster than the ROM.

4. RAM offers memory capacity in GB usually 1 to 256 GB
per chip. On the contrary, ROM permits the storage
capacity in MB, usually in the range 4 to 8 MB per chip.
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5. RAM stores data on transistors thus requires a continuous source of
power. While data stored in ROM remain unaffected with power failure.

6. The data stored in RAM is changeable by the user. Whereas the data in
ROM cannot be altered by the user.

7. RAM offers the user to read as well as write data but data in ROM is
pre-written and thus can only be read by the user.

8. The processor can directly access the data present in RAM. However, the
data present in ROM do not permit direct access to the processor.

9. The cost of Random access memory is comparatively higher than the
read-only memory.



RAM
61



Secondary Memory
62

 This type of memory is also known as external memory or
non-volatile.

 It is slower than the main memory.

 These are used for storing data/information permanently.

 CPU directly does not access these memories, instead they
are accessed via input-output routines.

 The contents of secondary memories are first transferred to
the main memory, and then the CPU can access it.

 For example, disk, CD-ROM, DVD, etc.



Characteristics of Secondary Memory
63

❖ These are magnetic and optical memories.

❖ It is known as the backup memory.

❖ It is a non-volatile memory.

❖ Data is permanently stored even if power is switched
off.

❖ It is used for storage of data in a computer.

❖ Computer may run without the secondary memory.

❖ Slower than primary memories.



Magnetic Tape
64

 In magnetic tape only one side of the ribbon is used for
storing data.

 It is sequential memory which contains thin plastic ribbon
to store data and coated by magnetic oxide.

 Data read/write speed is slower because of sequential
access. It is highly reliable which requires magnetic tape
drive writing and reading data.

 The width of the ribbon varies from 4mm to 1 Inch.
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Advantages
66

1. These are inexpensive, i.e., low cost memories.

2. It provides backup or archival storage.

3. It can be used for large files.

4. It can be used for copying from disk files.

5. It is a reusable memory.

6. It is compact and easy to store on racks.



Disadvantages
67

1. Sequential access is the disadvantage, means it

does not allow access randomly or directly.

2. It requires caring to store, i.e., vulnerable humidity,

dust free, and suitable environment.

3. It stored data cannot be easily updated or

modified, i.e., difficult to make updates on data.



Hard Disk
68

 •The Hard disk drive is the main and usually largest data
storage device in a computer.

 It is located inside the system case (cabinet).

 •It can store anywhere from 250 gigabytes to 2 terabytes.

 •Hard disk speed is the speed at which content can be read
and written on a hard disk.

 •A hard disk unit comes with a set rotation speed varying
from 4500 to 7200rpm.

 •Disk access time is measured in milliseconds.
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Floppy Disk
70

 The floppy disk (or a 3 1/2) is a removable Magnetic
Storage Medium.

 Floppy disks are used for moving information between
computers, laptops or other devices.

 Floppy disks are inserted into a floppy disk drive which
allows data to be read or stored.

 Floppy disks store much less data than a CD-ROM disk
or USB flash drive.
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 A normal 3½ inch disk can store 1.44 megabytes of data.
This is usually enough for simple text documents.

 A special type of floppy disk was made in the late 1980s. It
could store 2.88 MB of data.

 Floppy disk technology has been around since the early
1970s (the 8-inch floppy was the first).

 Today, floppy disks have been replaced by other storage
media, like USB flash drives.

 Floppy disks and drives are no longer manufactured.
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Compact Disk (CD):
73

 It stores data and it has circular plastic; single side of
the plastic is coated by aluminum alloy which stores
data. It is protected by additional thin plastic covering.
CD requires a CD drive for its operation.

 CDs can hold up to 700 MB worth of data, which is
about 80 minutes of music.

 CD's can be Classified as CD-R, CD-RW,CD-Audio,
Video CD or VCD and DVD.



USB
74

 A USB flash drive (USB stands for Universal Serial Bus) is a
popular way to store digital information.

 Flash drives are an easy way to share data (information).

 A USB flash drive can be attached to a USB port, and
provides a certain amount of storage space, which can be
used to store data.

 They are called "flash drive" because they use flash memory
to store files. Flash memory is a type of computer chip.
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 USB flash drives have some advantages over other portable
storage devices.

 They are physically much smaller and more rugged than
floppy disks. They can read data faster and store more
data than floppy disks.

 Flash drives are used to store any type of data file, or to
move data from one computer to another.

 USB flash drives have a lot of storage space. It is often
easier to use a flash drive than to carry many CD-ROMs.
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 Some computer programs can be run from a USB flash
drive. These special versions of programs are called
"portable" versions.

 Computer administrators, or people who manage the
computer systems, sometimes use flash drives.

 Sometimes flash drives are also used to run a computer virus
scanner. They are often used to repair a computer system
that was damaged or faulty.

 Most computers today can boot from a USB drive. Special
operating systems can run from a bootable flash drive.



DVD
77

 A DVD (which means Digital Versatile Disc or a
Digital Video Disc) is an optical disc capable of
storing up to 4.7 GB of data, more than six times
what a CD can hold.

 DVDs are often used to store movies at better
quality than a VHS.

 Like CDs, DVDs are read with a laser.
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 The disc can have one or two sides, and one or two layers of 
data per side; the number of sides and layers determines 
how much it can hold. A 12 cm diameter disc may have one 
of the following storage capacities:

 DVD-5: single sided, single layer, 4.7 gigabytes (GB)

 DVD-9: single sided, double layer, 8.5 GB .

 DVD-10: double sided, single layer on both sides, 9.4 GB 
DVD-14: double sided, double layer on one side, single layer on 
other, 13.3 GB)

 DVD-18: double sided, double layer on both sides, 17.1 GB



Blue Ray Disc
79

 Blu-ray Disc is a high-density optical disc format similar to DVD.

 A dual-layer Blu-ray disc can store up to 50GB (gigabytes) of data.
This is over five times the capacity of a DVD, and over 70 times
more than a CD or VCD.

 The disc was developed by the Blu-ray Disc Association (BDA) and
released in 2006. The format was developed for recording,
rewriting and playback of high-definition video (HD), as well as
storing large amounts of data.

 Older optical disc technologies such as DVD, DVD±R, DVD±RW, and
DVD-RAM used a red laser to read and write data. The new format
used a blue-violet laser instead.
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INPUT DEVICES



Input Devices

 Any device that allows information from outside the computer

to be communicated to the computer is considered as an Input

Device.

 These include a Keyboard, Mouse, Trackball, Spaceball,

Joystick, Light Pens, Barcode readers, Image Scanners, Touch

Panels and Magnetic Ink Character Recognition (MICR).

 Analog- Mouse, Trackball, Scanner, Joystick.

 Digital- Keyboard, Light pen, Touch panels.



Keyboards
 Keyboard is used to enter the data into a computer.

 Generally 108 keys are in keyboard.

 It consists of Alphanumeric keys, function keys , Cursor control keys and Control
Keys.

 Alphanumeric Keys include (A-Z),(0-9),(`~!@#$%^&*()_-+={}:”;<>?,./)

 Cursor-control keys and function keys are common features on general
purpose keyboards.

 Function keys (F1 to F12) allow users to enter frequently used operations in a
single keystroke, and cursor-control keys can be used to select displayed
objects or coordinate positions by positioning the screen cursor.

 Special Keys include Enter Key, Backspace, Number Lock, Caps Lock, Ctrl,
Shift.





Mouse

 A mouse is small hand-held box used to position the screen cursor.

 Wheels or rollers on the bottom of the mouse can be used to record
the amount and direction of movement.

 Another method for detecting mouse motion is with an optical sensor.
For these systems, the mouse is moved over a special mouse pad that
has a grid of horizontal and vertical lines.

 The optical sensor detects movement across the lines in the grid.



 There are three types of mouse.

 Mechanical mouse: Houses a hard rubber ball that rolls as the mouse is
moved. Sensors inside the mouse body detect the movement and translate it
into information that the computer interprets.

 Optical mouse: Uses an LED sensor to detect tabletop movement and then
sends off that information to the computer for merry munching.

 Infrared (IR) or radio frequency cordless mouse: With both these types,
the mouse relays a signal to a base station wired to the computer’s mouse
port. The cordless mouse requires power, which comes in the form of
batteries.







Trackball 

 A trackball is a computer pointing device which can perform
the same functions as a mouse.

 With a trackball, The user rolls the ball to direct the cursor
to the desired place on the screen and can click one of two
buttons (identical to mouse buttons) near the trackball to
select desktop objects or position the cursor for text entry.

 A trackball spins very freely, so a simple flick of your
fingers will produce a scroll much longer than a movement
with a mouse.







Spaceball

 A graphical input device that is based on a fixed spherical ball. It allows complex
objects to be positioned and rotated in three-dimensional space using the single
input device.

 While a trackball is a two-dimensional positioning device, whereas a Spaceballs
provides six degrees of freedom.

 Unlike the trackball, a Spaceballs does not actually move.

 Strain gauges measure the amount of pressure applied to the spaceballs to provide
input for spatial positioning and orientation as the ball is pushed or pulled in various
directions.

 Spaceballs are used for three-dimensional positioning and selection operations in
virtual-reality systems, modeling, animation, CAD, and other applications.







Joystick

 A joystick consists of a small, vertical lever (called the stick) mounted on a base that
is used to steer the screen cursor around.

 Most joysticks select screen positions with actual stick movement; others respond to
pressure on the stick.

 Some joysticks are mounted on a keyboard; others function as stand-alone units.

 The distance that the stick is moved in any direction from its center position
corresponds to screen-cursor movement in that direction.

 Potentiometers mounted at the base of the joystick measure the amount of
movement, and springs return the stick to the center position when it is released.

 One or more buttons can be programmed to act as input switches to signal certain
actions once a screen position has been selected.







Light Pen

 A light pen is a computer input device in the form of a light-sensitive wand
used in conjunction with a computer's cathode-ray tube (CRT) display.

 It allows the user to point to displayed objects or draw on the screen in a
similar way to a touchscreen but with greater positional accuracy.

 A light pen can work with any CRT-based display, but its ability to be used
with LCDs.

 A light pen may also be used to describe the pen (stylus) used with a
graphics tablet.

 Today, light pens are no longer used due to the invention of touch screens.



Light pen





Touch Panels

 Touch panels allow displayed objects or screen positions to be selected with the
touch of a finger.

 A typical application of touch panels is for the selection of processing options that
are represented with graphical icons.

 Some systems can be adapted for touch input by fitting a transparent device with a
touch sensing mechanism over the video monitor screen.

 Touch input can be recorded using optical, electrical, or acoustical methods.

 Optical touch panels employ a line of infrared light-emitting diodes (LEDs) along
one vertical edge and along one horizontal edge of the frame.

 The opposite vertical and horizontal edges contain light detectors. These detectors
are used to record which beams are interrupted when the panel is touched.





Image Scanners

 A Scanner is a device that optically scans Images, Printed Text,
Handwriting or An Object and converts it to a digital image.

 Generally in the Flatbed scanners, the document is placed on a
Glass Window for scanning.

 Drawings, Graphs, Color and Black-and-white photos, or Text can be
stored for computer processing with an Image Scanner by passing
an optical scanning mechanism over the information to be stored.

 Finally, it stores the image information in a specific file format such
as JPEG, GIF, TIFF, BMP, PDF documents and so on.



Types of Scanner

 Flat bed Scanners- also called as Desktop Scanners, are the most
versatile and commonly used scanners.

 Sheet bed Scanners- are similar to the flatbed scanners except the
document is moved and the scan head is immoveable. A sheet bed
scanner looks a lot like a small portable printer.

 Hand held Scanners- uses the same basic technology as a flatbed
scanner, but rely on the user to move them instead of a motorized
belt. This type of scanner typically does not provide good image
quality. However, it can be useful for capturing an image quickly.



 Drum Scanners- are used by the publishing industry to
capture incredibly detailed images.

 They use a technology called Photo Multiplier Tube (PMT).

 In PMT, the document to be scanned is mounted on a glass
cylinder. Located at the center of the cylinder is a sensor
that splits light bounced from the document into three beams.

 Each beam is sent through a colour filter into a photo
multiplier tube where the light is changed into electrical
signal.



Flat bed Scanner



Sheet fed Scanner



Hand held Scanner



Drum Scanner



Magnetic Ink Character Recognition (MICR)

 Magnetic ink character recognition code, known in short as MICR code, is
a character recognition technology used mainly by the banking industry to
streamline the processing and clearance of cheques and other documents.

 MICR encoding, called the MICR line, is at the bottom of cheques and other
vouchers and typically includes the document-type indicator, bank code,
bank account number, cheque number, cheque amount (usually added after
a cheque is presented for payment), and a control indicator.

 The MICR read head is a device built into the scanner designed to read the
magnetic signal emitted by the MICR ink characters on the check. Each
character produces a unique waveform which is read and translated by the
MICR read head.







Optical Mark Recognition(OMR)

 Optical mark recognition (also called optical mark reading
and OMR) is the process of capturing human-marked data
from document forms such as surveys and tests.

 They are used to read questionnaires, multiple choice
examination paper in the form of lines or shaded areas.

 Optical Mark Readers reads pencil or pen marks made in
pre-defined positions on paper forms as responses to
questions or tick list prompts.





Optical Character Recognition

 Optical character recognition or optical character

reader (OCR) is the electronic or mechanical

conversion of images of typed, handwritten or

printed text into machine-encoded text, whether

from a scanned document, a photo of a document,

a scene-photo (for example the text on signs and

billboards in a landscape photo)





HARD COPY DEVICES



Hard copy devices

 The computer processes input data to produce useful information.

 This information can be displayed or viewed on a monitor, printed
on a printer or listened through speakers or headset or it can be
stored in the secondary memory device for further processing or
future reference.

 The different ways of output can be broadly classified as
✓ Hard copy

✓ Soft copy.

Soft Copy: The electronic version of an output, which usually resides in
computer memory and/or on disk is known as Soft Copy. Soft copy
output also includes audio and visual form of output generated using
computer.



 Hard Copy: Hard-copy devices are the entities that produce the
output which can be retained over the time. That is, nothing but
printing over the paper.

 Hard- copy devices can be classified into two categories; one is
the Printers and second is the Plotters.

 The quality of the pictures obtained from a device depends on
dot size and the number of dots per inch, or Lines per inch, that
can be displayed.

 To produce smooth characters in printed text strings, higher -
quality printers shift dot positions so that adjacent dots overlap.



Monitors

 A computer monitor is an output device that displays information in
pictorial form.

 The monitor displays the computer's user interface and open programs,
allowing the user to interact with the computer, typically using the keyboard
and mouse.

 The size of the computer screen is measured diagonally from corner to
corner in inches.

 For desktop computers, common sizes are 13,15,17,19 and 21 inches.

 For laptop computers, 12.1,13.3,14.1 inches.

 There are two types of monitors: 1) Cathode Ray Tubes, 2) Liquid Crystal
Display.



Printers 

 Printer is an output device, which is used to print information
on paper.

 There are two types of printers −
 Impact Printers

 Non-Impact Printers

 Impact printers print the characters by striking them on the
ribbon, which is then pressed on the paper.

 Non-impact printers print the characters without using the
ribbon. These printers print a complete page at a time,



Impact printers

 Characteristics of Impact Printers are the following −

 Very low consumable costs.

 Very noisy

 Useful for bulk printing due to low cost

 There is physical contact with the paper to produce an image

 These printers are of two types −

 Character printers

 Line printers



Character Printers

 Character printers are the printers which print one character at a 
time.

 Dot Matrix Printer

 Dot matrix has printed in the form of dots. A printer has a head
which contains nine pins. The nine pins are arranged one below
other. Each pin can be activated independently. All or only the same
needles are activated at a time. When needless is not activated,
and then the tip of needle stay in the head. When pin work, it comes
out of the print head. In nine pin printer, pins are arranged in 5 * 7
matrixes.



 Advantages

 Inexpensive

 Widely Used

 Other language characters can be printed

 Disadvantages

 Slow Speed

 Poor Quality







Line Printers

 Line Printers are the printers which print one line at a time.

 These are of two types −
 Drum Printer

 Chain Printer

 Drum Printer

 This printer is like a drum in shape hence it is called drum printer.

 The surface of the drum is divided into several tracks.

 Total tracks are equal to the size of the paper, i.e. for a paper
width of 132 characters, drum will have 132 tracks.



 A character set is embossed on the track. Different character sets available
in the market are 48-character set, 64 and 96 characters set.

 One rotation of drum prints one line.

 Drum printers are fast in speed and can print 300 to 2000 lines per minute.

 Advantages

 Very high speed

 Disadvantages

 Very expensive

 Characters fonts cannot be changed



Chain Printer

 In this printer, a chain of character sets is used, hence it is 
called Chain Printer. A standard character set may have 48, 
64, or 96 characters.

 Advantages

 Character fonts can easily be changed.

 Different languages can be used with the same printer.

 Disadvantages

 Noisy



Cylinder of  Drum Printer



Drum Printers



Chain Printers



Line Printers



Non-impact Printers

 Non-impact printers print the characters without using the ribbon. These printers
print a complete page at a time; thus they are also called as Page Printers.

 These printers are of two types −

 Laser Printers

 Inkjet Printers

 Characteristics of Non-impact Printers

 Faster than impact printers

 They are not noisy

 High quality

 Supports many fonts and different character size



Laser Printers

 They use laser lights to produce the dots needed to form the characters to
be printed on a page.

 Advantages

 Very high speed

 Very high-quality output

 Good graphics quality

 Supports many fonts and different character size

 Disadvantages

 Expensive

 Cannot be used to produce multiple copies of a document in a single printing







Colour Laser Printer

 A colour laser printer works like a single laser printer, except

that the process is repeated four times with four different ink

colours: Cyan, magenta, yellow and black.

 Laser printers have high resolution from 600 dots per inch upto

1200 per inch.

 These printers print 4 to 16 page of text per minute.

 The high quality and speed of laser printers make them ideal

for office environment.



Inkjet Printers

 Inkjet printers are non-impact character printers based on a relatively new
technology. They print characters by spraying small drops of ink onto paper.
Inkjet printers produce high quality output with presentable features.

 They make less noise because no hammering is done, and these have many
styles of printing modes available. Color printing is also possible. Some
models of Inkjet printers can produce multiple copies of printing also.

 Advantages

 High quality printing

 More reliable

 Disadvantages

 Expensive as the cost per page is high

 Slow as compared to laser printer



Ink jet Printers



Plotters

 Plotters are a special type of output device. It is suitable for 
applications:

 Architectural plan of the building.

 CAD applications like the design of mechanical components of aircraft.

 Many engineering applications.

Advantage:

 It can produce high-quality output on large sheets.

 It is used to provide the high precision drawing.

 It can produce graphics of various sizes.

 The speed of producing output is high.



 Drum Plotter:

 It consists of a drum. Paper on which design is made is kept on the drum. The drum
can rotate in both directions. Plotters comprised of one or more pen and penholders.
The holders are mounted perpendicular to drum surface. The pens are kept in the
holder, which can move left to the right as well as right to the left. The graph
plotting program controls the movement of pen and drum.

 Flatbed Plotter:

 It is used to draw complex design and graphs, charts. The Flatbed plotter can be
kept over the table. The plotter consists of pen and holder. The pen can draw
characters of various sizes. There can be one or more pens and pen holding
mechanism. Each pen has ink of different color. Different colors help to produce
multicolor design of document. The area of plotting is also variable. It can vary A4
to 21'*52'.
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Software
146

 Computer software is a collection of data or computer instructions
that tell the computer how to work.

 This contrasts with physical hardware, from which the system is built
and performs the work.

 Software is all about information processed by computer systems,
programs and data.

 Computer software includes computer programs, libraries and
related non-executable data, such as online documentation or
digital media.

 Examples of applications include office suites, database programs,
web browsers, word processors,



Software Types
147

 There are two main types of software:

 Systems software

 Application software.

 System Software can be designed as the software in such a
way so that it can control and work with computer hardware.

 System software is also designed for providing a platform
for running application software such as the operating
system, file management utilities, and disk operating system
(or DOS).
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 System software is a software that provides
platform to other software's.

 Some examples can be operating systems, antivirus
software's, disk formatting software's, Computer
language translators etc.

 System software serves as the interface between
the hardware and the end users.



Operating System (OS)
149

 An operating system (OS) is a system software that
manages computer’s hardware and software resources.

 An operating system is a collection of system programs that
together controls the operation of a computer system.

 It provides common services for computer programs.

 It controls and keeps a record of the execution of all other
programs that are present in the computer, including
application programs and other system software.

 Example: Linux, Unix, Microsoft Windows etc.



Device Driver
150

 Device Driver are essential piece of system software.

 Operating systems act as a link between hardware and
software which enables both to communicate and do their
tasks.

 A device driver is a specially written program which
translates the commands from the operating system into
commands that the specific hardware will understand.

 Each piece of hardware has its own driver.

 Devices from different manufactures work in different ways.



Utility software
151

 Utility software is a kind of system software which acts as an
interface between system software and application software.

 These are those programs which are specifically designed for some
particular purpose like maintenance of the computer or diagnose
any error in the computer.

 Generally, these are third-party tools which come along with the
operating system.

 Some Examples includes File Viewer, File Compressor, Disk Scanner,
Antivirus, Disk Defragmenter, Backup Utility and Data Recovery
Utility.



Application Software
152

 Application software is a computer software which is
designed to help the user to perform single or multiple
related tasks.

 Applications software can deal with user inputs and helps
the user to complete the task. It is also called end-user
programs.

 Examples of an application include a word processor, a
spreadsheet, an accounting application, a web browser, an
email client, a media player, a file viewer, simulators, a
console game or a photo editor.



Difference between System Software and Application Software
153

System Software Application Software

We make use of system software for operating hardware of 

the computer.

The user makes use of application software to perform 

some specific task.

When the operating system is installed on the computer, 

then the system software is also mounted on the machine.

We install the application software according to the 

requirement of the user.

System software works in the background. So the user is 

not able to interact with it.
Generally, the user interacts with the application software.

It can run independently as it provides the platform for the 

running application softwares.

It can’t run independently because it is not able to run 

without the presence of system software.

Example: compiler, assembler, interpreter etc.. Example: word processor, web browser, media player etc.



Programming Languages
154

 Machine language is the low level programming language.

 Machine language can only be represented by 0s and 1s.

 In earlier when we have to create a picture or show data on
the screen of the computer then it is very difficult to draw
using only binary digits(0s and 1s).

 For example: To write 120 in the computer system its
representation is 1111000. So it is very difficult to learn. To
overcome this problem the assembly language is invented.
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 Assembly language is the more than low level and less

than high-level language so it is intermediary language.

 Assembly languages use numbers, symbols, and

abbreviations instead of 0s and 1s.

For example:

 For addition, subtraction and multiplications it uses

symbols likes Add, sub and Mul, etc.
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Machine Language Assembly Language

Machine language is only understood by the 

computers.

Assembly language is only understand by 

human beings not by the computers.

In machine language data only represented 

with the help of binary format(0s and 1s), 

hexadecimal and octadecimal.

In assembly language data can be 

represented with the help of mnemonics such 

as Mov, Add, Sub, End etc.

Machine language is very difficult to 

understand by the human beings.

Assembly language is easy to understand by 

the human being as compare to machine 

language.

Modifications and error fixing cannot be 

done in machine language.

Modifications and error fixing can be done 

in assembly language.
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Machine Language Assembly Language

Machine language is very difficult to 

memorize so it is not possible to learn the 

machine language.

Easy to memorize the assembly language 

because some alphabets and mnemonics 

are used.

Execution is fast in machine language 

because all data is already present in 

binary format.

Execution is slow as compared to machine 

language.

There is no need of translator.The 

machine understandable form is the 

machine language.

Assembler is used as translator to convert 

mnemonics into machine understandable 

form.

Machine language is hardware 

dependent.

Assembly language is the machine 

dependent and it is not portable.

Machine language is very difficult to 

memorize so it is not possible to learn the 

machine language.

Easy to memorize the assembly language 

because some alphabets and mnemonics 

are used.



High level Language
159

 High level languages are instructions, which are called
as statements that use brief statements or arithmetic
expressions.

 High level language statements resemble the phrases or
mathematics expression required to express the
problem or procedure being programmed.

 Most common programming languages are considered
high-level languages. Examples include C++,C#, Cobol,
Java, JavaScript, PHP, Python, etc.,
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 Each of these languages use different syntax.

 Some are designed for writing desktop software programs, while
others are best-suited for web development. But they all are
considered high-level since they must be processed by a compiler or
interpreter before the code is executed.

 Source code written in languages like C++ and C# must be
compiled into machine code in order to run. The compilation process
converts the human-readble syntax of the high-level language into
low-level code for a specific processor.

 Source code written in scripting languages like Perl and PHP can be
run through an interpreter, which converts the high-level code into a
low-level language on-the-fly.



Advantages 
161

1. High level languages are programmer friendly. They
are easy to write, debug and maintain.

2. It provide higher level of abstraction from machine
languages.

3. It is machine independent language.

4. Easy to learn.

5. Less error prone, easy to find and debug errors.

6. High level programming results in better programming
productivity.



Disadvantages 
162

1. It takes additional translation times to translate the
source to machine code.

2. High level programs are comparatively slower than
low level programs.

3. Compared to low level programs, they are
generally less memory efficient.

4. Cannot communicate directly with the hardware.
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High Level Language Low Level Language

It is programmer friendly language. It is a machine friendly language.

High level language is less memory efficient. Low level language is high memory efficient.

It is easy to understand. It is tough to understand.

It is simple to debug. It is complex to debug comparatively.

It is simple to maintain. It is complex to maintain comparatively.

It is portable. It is non-portable.

It can run on any platform. It is machine-dependent.

It needs compiler or interpreter for translation. It needs assembler for translation.

It is used widely for programming.
It is not commonly used now-a-days in 

programming.



Language Processors
164

 The language processor that reads the complete source
program written in high level language in one go and
translates it into an equivalent program in machine
language is called as a Compiler.

 Example: C, C++, C#, Java.

 In a compiler, the source code is translated to object code
successfully if it is free of errors. The compiler specifies the
errors at the end of compilation with line numbers when
there are any errors in the source code. The errors must be
removed before the compiler can successfully recompile the
source code again
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Assembler
166

 The Assembler is used to translate the program

written in Assembly language into machine code.

The source program is an input of assembler that

contains assembly language instructions. The output

generated by assembler is the object code or

machine code understandable by the computer.
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Interpreter
168

 The translation of single statement of source program into machine code is
done by language processor and executes it immediately before moving on
to the next line is called an interpreter.

 If there is an error in the statement, the interpreter terminates its translating
process at that statement and displays an error message.

 The interpreter moves on to the next line for execution only after removal of
the error.

 An Interpreter directly executes instructions written in a programming or
scripting language without previously converting them to an object code or
machine code.

 Example: Perl, Python and Matlab.
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Compiler Interpreter

A compiler is a program which coverts the entire

source code of a programming language into

executable machine code for a CPU.

interpreter takes a source program and

runs it line by line, translating each line as

it comes to it.

Compiler takes large amount of time to analyze the

entire source code but the overall execution time of

the program is comparatively faster.

Interpreter takes less amount of time to

analyze the source code but the overall

execution time of the program is slower.

Compiler generates the error message only after

scanning the whole program, so debugging is

comparatively hard as the error can be present any

where in the program.

Its Debugging is easier as it continues

translating the program until the error is

met

Generates intermediate object code. No intermediate object code is generated.

Examples: C, C++, Java Examples: Python, Perl
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Operating System
171

 An Operating System (OS) is an interface between a computer user
and computer hardware. An operating system is a software which
performs all the basic tasks like file management, memory
management, process management, handling input and output, and
controlling peripheral devices such as disk drives and printers.

 Some popular Operating Systems include Linux Operating System,
Windows Operating System, VMS, OS/400, AIX, z/OS, etc.

 An operating system is a program that acts as an interface
between the user and the computer hardware and controls the
execution of all kinds of programs.
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 Following are some of important functions of an operating System.

 Memory Management

 Processor Management

 Device Management

 File Management

 Security

 Control over system performance

 Job accounting

 Error detecting aids

 Coordination between other software and users



Memory Management
174

 An Operating System does the following activities for
memory management −
 Keeps tracks of primary memory, i.e., what part of it are in

use by whom, what part are not in use.

 In multiprogramming, the OS decides which process will get
memory when and how much.

 Allocates the memory when a process requests it to do so.

 De-allocates the memory when a process no longer needs it
or has been terminated.



Processor Management
175

 In multiprogramming environment, the OS decides which
process gets the processor when and for how much time. This
function is called Process Scheduling.

 An Operating System does the following activities for
processor management −
 Keeps tracks of processor and status of process. The program

responsible for this task is known as traffic controller.

 Allocates the processor (CPU) to a process.

 De-allocates processor when a process is no longer required.



Device Management
176

 An Operating System manages device communication
via their respective drivers. It does the following
activities for device management −
 Keeps tracks of all devices. Program responsible for this

task is known as the I/O controller.

 Decides which process gets the device when and for how
much time.

 Allocates the device in the efficient way.

 De-allocates devices.



File Management
177

 A file system is normally organized into directories for
easy navigation and usage. These directories may
contain files and other directions.

 An Operating System does the following activities for
file management −

 Responsible for creation and deletion of files and
directories.

 It takes file related activities such as organizing, storing,
retrieving, naming and processing the files.
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• Security − By means of password and similar other techniques, it prevents
unauthorized access to programs and data.

• Control over system performance − Recording delays between request for
a service and response from the system.

• Job accounting − Keeping track of time and resources used by various jobs
and users.

• Error detecting aids − Production of dumps, traces, error messages, and
other debugging and error detecting aids.

• Coordination between other software’s and users − Coordination and
assignment of compilers, interpreters, assemblers and other software to the
various users of the computer systems.



Types of Operating System
179

Batch operating system

 The users of a batch operating system do not interact with the computer directly.
Each user prepares his job on an off-line device like punch cards and submits it to
the computer operator. To speed up processing, jobs with similar needs are batched
together and run as a group. The programmers leave their programs with the
operator and the operator then sorts the programs with similar requirements into
batches.

 The problems with Batch Systems are as follows −

 Lack of interaction between the user and the job.

 CPU is often idle, because the speed of the mechanical I/O devices is slower than the CPU.

 Difficult to provide the desired priority.



Time-sharing operating systems
180

 Time-sharing is a technique which enables many people,
located at various terminals, to use a particular computer
system at the same time. Time-sharing or multitasking is a
logical extension of multiprogramming. Processor's time
which is shared among multiple users simultaneously is
termed as time-sharing.

 The main difference between Multi programmed Batch
Systems and Time-Sharing Systems is that in case of Multi
programmed batch systems, the objective is to maximize
processor use, whereas in Time-Sharing Systems, the
objective is to minimize response time.
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 Multiple jobs are executed by the CPU by switching between them,
but the switches occur so frequently. Thus, the user can receive an
immediate response. For example, in a transaction processing, the
processor executes each user program in a short burst or quantum of
computation. That is, if n users are present, then each user can get a
time quantum. When the user submits the command, the response
time is in few seconds at most.

 The operating system uses CPU scheduling and multiprogramming to
provide each user with a small portion of a time. Computer systems
that were designed primarily as batch systems have been modified
to time-sharing systems.



Network Operating System
182

 A Network Operating System runs on a server and provides the
server the capability to manage data, users, groups, security,
applications, and other networking functions.

 The primary purpose of the network operating system is to allow
shared file and printer access among multiple computers in a
network, typically a local area network (LAN), a private network or
to other networks.

 Examples of network operating systems include Microsoft Windows
Server 2003, Microsoft Windows Server 2008, UNIX, Linux, Mac
OS X, Novell NetWare, and BSD.



Desktop Operating System
183

 Operating system that run on desktop computes are most
common. Generally the operating system include Windows,
Mac OS and DOS.

 Windows has many versions and the latest is Windows 10.

 Windows is currently the leading desktop operating systems.

 Mac OS runs on Apple Macintosh and PowerPC was the first
widely used operating systems with GUI.



Mainframe Operating Systems
184

 Currently, mainframes and mini frames dominated the
computing world, each computer company developed
its own operating system.

 For example: IBM mainframe computers use an
operating system called OS/Z and digital Equipment
corporation use OpenVMS.

 These companies developed not only their own
operating systems but also the applications that run on
top of them.



Examples of Operating System

 Windows 1.0

 Windows 2.0

 Windows 3.0

 Windows 3.1

 Windows NT 3.1

 Windows 95

 Windows NT 4.0

 Windows 98

 Windows Millennium Edition (ME)

 Windows 2000 Professional

 Windows XP

 Windows Vista

 Windows 7

 Windows 2008

 Windows 8

 Windows 10
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Computer Networks
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 A Computer network is a group of computers linked to
each other that enables the computer to communicate
with another computer and share their resources, data,
and applications.

 A network is a set of nodes connected by
communication links. A node can be a computer, printer,
or any other device capable of sending or receiving
data from the other node through the network.



Components of Computer Network
188

 Servers - Servers are computers that hold shared files,
programs, and the network operating system.

 Servers provide access to network resources to all the users
of the network.

 There are many kinds of servers, and one server can
provide several functions.

 Sometimes it is also called host computer, servers are
powerful computer that store data or application and
connect to resources that are shared by the user of a
network.
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 For example, there are file servers, print servers, mail
servers, communication servers, database servers, fax
servers and web servers, to name a few.

 Clients - Clients are computers that access and use the
network and shared network resources.

 Client computers are basically the customers(users) of
the network, as they request and receive services from
the servers.
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 Transmission Media - Transmission media are the facilities used to
interconnect computers in a network, such as twisted-pair wire,
coaxial cable, and optical fiber cable. Transmission media are
sometimes called transmission medium channels, links or lines.

 Shared data - Shared data are data that file servers provide to
clients such as data files, printer access programs and e-mail.

 Shared printers and other peripherals - Shared printers and
peripherals are hardware resources provided to the users of the
network by servers. Resources provided include data files, printers,
software, or any other items used by clients on the network.
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 Network Interface Card - Each computer in a network has a
special extension card called a network interface card
(NIC).

 The NIC prepares(formats) and sends data, receives data,
and controls data flow between the computer and the
network.

 On the transmit side, the NIC passes frames of data on to
the physical layer, which transmits the data to the physical
link. On the receiver's side, the NIC processes bits received
from the physical layer and processes the message based on
its contents.
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Uses of Computer Networks
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 Information and Resource Sharing − Computer networks allow
organizations having units which are placed apart from each other,
to share information in a very effective manner. Programs and
software in any computer can be accessed by other computers linked
to the network. It also allows sharing of hardware equipment, like
printers and scanners among varied users.

 Retrieving Remote Information − Through computer networks, users
can retrieve remote information on a variety of topics. The
information is stored in remote databases to which the user gains
access through information systems like the World Wide Web.
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 Speedy Interpersonal Communication − Computer networks have
increased the speed and volume of communication like never before.
Electronic Mail (email) is extensively used for sending texts,
documents, images, and videos across the globe. Online
communications have increased by manifold times through social
networking services.

 E-Commerce − Computer networks have paved way for a variety of
business and commercial transactions online, popularly called e-
commerce. Users and organizations can pool funds, buy or sell items,
pay bills, manage bank accounts, pay taxes, transfer funds and
handle investments electronically.
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 Highly Reliable Systems − Computer networks allow systems to be
distributed in nature, by the virtue of which data is stored in multiple
sources. This makes the system highly reliable. If a failure occurs in one
source, then the system will still continue to function and data will still be
available from the other sources.

 Cost–Effective Systems − Computer networks have reduced the cost of
establishment of computer systems in organizations. Previously, it was
imperative for organizations to set up expensive mainframes for
computation and storage. With the advent of networks, it is sufficient to set
up interconnected personal computers (PCs) for the same purpose.

 VoIP or Voice over Internet protocol has revolutionized telecommunication
systems. Through this, telephone calls are made digitally using Internet
Protocols instead of the regular analog phone lines.
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 A computer network can be categorized by their
size. A computer network is mainly of four
types:

 PAN(Personal Area Network)

 LAN(Local Area Network)

MAN(Metropolitan Area Network)

WAN(Wide Area Network)



PAN(Personal Area Network)
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❖ Personal Area Network is a network arranged within an
individual person, typically within a range of 10 meters.

❖ Personal Area Network is used for connecting the computer
devices of personal use is known as Personal Area Network.

❖ Thomas Zimmerman was the first research scientist to bring
the idea of the Personal Area Network.

❖ Personal Area Network covers an area of 30 feet.

❖ Personal computer devices that are used to develop the
personal area network are the laptop, mobile phones,
media player and play stations.
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LAN(Local Area Network)
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 Local Area Network is a group of computers connected to
each other in a small area such as Home, building, office.

 LAN is used for connecting two or more personal computers
through a communication medium such as twisted pair,
coaxial cable, etc.

 It is less costly as it is built with inexpensive hardware such
as hubs, network adapters, and ethernet cables.

 The data is transferred at an extremely faster rate in Local
Area Network.

 Local Area Network provides higher security.
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Advantages
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 Using LAN, we can share the hardware and software
resources like printers, FAX, drivers and hard-disk as
they are on one platform and thus this type of network
turns out to be cost-effective.

 As being connected on the network, the offices or firms
using the same type of software for job purposes need
not purchase separately for each of the host clients as
the software can easily be shared with everyone on an
equal level.
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 LAN network works as a client-server model, therefore data can be

stored centrally on one PC called as a server in a network and it

can be accessible to all the other client PC’s via LAN. By following

this method, we need not store data locally at one single node.

 Communication will be handy and economical by using LAN network.

 Internet cafe owners use the LAN network to provide internet

connections to multiple nodes and users connected via a single

internet connection. This makes the use of the internet a cost-

effective one.



Disadvantages 
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 The initial installation cost of the network is very high.

 It is having a geographical area limitation and can only cover a
small area.

 As it works on a single cable, if it gets faulty then the overall
network will stop working. Hence, it needs a full -time maintenance
officer called an administrator.

 Crucial Data of offices or factories is saved on a single server which
can easily be accessible by all the nodes thus it is having all time
data security issues as any unauthorized person can also access the
confidential data.



MAN(Metropolitan Area Network)
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 A metropolitan area network is a network that covers a
larger geographic area by interconnecting a different LAN
to form a larger network.

 Government agencies use MAN to connect to the citizens
and private industries.

 In MAN, various LANs are connected to each other through a
telephone exchange line.

 It has a higher range than Local Area Network(LAN).

 Cable Television network is the best example for MAN.
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Advantages
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❑ It is very efficient and swift for communication over
fiber optic cable for interconnection of networks in
cities.

❑ It serves many villages and cities and thus provides
great inter-connectivity at a low cost.

❑ The data can be transmitted or received simultaneously
over nodes and if one link fails the other will keep the
network live.



Disadvantages
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 Depending upon the distance between two nodes, the
cable length required for inter-connection differs every
time. Thus greater will be the cable length, the more will
be the cost of the network.

 Security is a big concern for this network as for such a
big distance anyone can hack the network. We can’t put
security at each level of the network, hence it becomes
easier for unwanted people to access it for their own
benefits.



WAN(Wide Area Network)
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❖ A Wide Area Network is a network that extends over a
large geographical area such as states or countries.

❖ A Wide Area Network is quite bigger network than the
LAN.

❖ A Wide Area Network is not limited to a single location, but
it spans over a large geographical area through a
telephone line, fibre optic cable or satellite links.

❖ The internet is one of the biggest WAN in the world.

❖ A Wide Area Network is widely used in the field of
Business, government, and education.
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Advantages of WAN
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✓ Geographical area: A Wide Area Network provides a
large geographical area. Suppose if the branch of our
office is in a different city then we can connect with them
through WAN. The internet provides a leased line through
which we can connect with another branch.

✓ Centralized data: In case of WAN network, data is
centralized. Therefore, we do not need to buy the emails,
files or back up servers.

✓ Get updated files: Software companies work on the live
server. Therefore, the programmers get the updated files
within seconds.



Advantages
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✓ Exchange messages: In a WAN network, messages are transmitted
fast. The web application like Facebook, Whatsapp, Skype allows
you to communicate with friends.

✓ Sharing of software and resources: In WAN network, we can share
the software and other resources like a hard drive, RAM.

✓ Global business: We can do the business over the internet globally.

✓ High bandwidth: If we use the leased lines for our company then
this gives the high bandwidth. The high bandwidth increases the data
transfer rate which in turn increases the productivity of our company.



Disadvantages
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• Security issue: A WAN network has more security issues as compared to
LAN and MAN network as all the technologies are combined together that
creates the security problem.

• Needs Firewall & antivirus software: The data is transferred on the
internet which can be changed or hacked by the hackers, so the firewall
needs to be used. Some people can inject the virus in our system so antivirus
is needed to protect from such a virus.

• High Setup cost: An installation cost of the WAN network is high as it
involves the purchasing of routers, switches.

• Troubleshooting problems: It covers a large area so fixing the problem is
difficult.



Internetwork
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 An internetwork is defined as two or more computer
network LANs or WAN or computer network segments
are connected using devices, and they are configured
by a local addressing scheme. This process is known as
internetworking.

 An interconnection between public, private, commercial,
industrial, or government computer networks can also
be defined as internetworking.

 An internetworking uses the internet protocol.
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LAN MAN WAN

Local Area Network is a

group of computers connected

to each other in a small area.

Metropolitan Area Network is

a larger network of computers

and other network devices

which are connected together

usually spans several

buildings.

A Wide Area Network is a

network that extends over a

large geographical area such

as states or countries.

LAN has very high speed Slow compared to LAN Various based on

geographical location of the

servers

Speeds can be 10mbps to

1000 mbps

Speed can be 10 or 100

Mbps

Speed can be 10 or 100

Mbps

Uses Guided Media Uses Guided or Unguided

Media

Uses Guided or Unguided

Media



Network Topology
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 Geometric representation of how the computers are
connected to each other is known as Network topology.

 There are five types of topology –

 Mesh Topology,

 Star Topology,

 Bus Topology,

 Ring Topology

 Tree Topology.



Mesh Topology
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 In mesh topology each device is connected to every other device on
the network through a dedicated point-to-point link.

 Dedicated lines means that the link only carries data for the two
connected devices only.

 Mesh technology comes into two types:

 Full Mesh: All hosts have a point-to-point connection to every other host 
in the network. Thus for every new host n(n-1)/2 connections are 
required. It provides the most reliable network structure among all 
network topologies.

 Partially Mesh: Not all hosts have point-to-point connection to every 
other host. Hosts connect to each other in some arbitrarily fashion. This 
topology exists where we need to provide reliability to some hosts out 
of all.



Mesh Topology
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• If suppose, N number of devices are connected with each 
other in mesh topology, then total number of ports that is 
required by each device is  N-1. 

• In the Figure 1, there are 5 devices connected to each other, 
hence total number of ports required is 4.

 If suppose, N number of devices are connected with each 
other in mesh topology, then total number of dedicated links 
required to connect them is NC2 i.e. N(N-1)/2.

 In the Figure 1, there are 5 devices connected to each other, 
hence total number of links required is 5*4/2 = 10.
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1. No data traffic issues as there is a dedicated link between two
devices which means the link is only available for those two
devices.

2. Mesh topology is reliable and robust as failure of one link doesn’t
affect other links and the communication between other devices on
the network.

3. Mesh topology is secure because there is a point to point link thus
unauthorized access is not possible.

4. Fault detection is easy.

5. Adding new devices would not disrupt the communication between
other devices.



Disadvantages
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1. Amount of wires required to connected each system is
tedious and headache.

2. Since each device needs to be connected with other
devices, number of I/O ports required must be huge.

3. Cost of maintenance is high.

4. Scalability issues because a device cannot be
connected with large number of devices with a
dedicated point to point link.



Star Topology
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 In Star topology, each device in the network is
connected to a central device called hub.

 Unlike Mesh topology, star topology doesn’t allow
direct communication between devices, a device must
have to communicate through hub.

 If one device wants to send data to other device, it has
to first send the data to hub and then the hub transmit
that data to the designated device.



Star Topology
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Advantages
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1. Less expensive because each device only need one I/O port and needs
to be connected with hub with one link.

2. Less amount of cables required because each device needs to be
connected with the hub only.

3. Robust, if one link fails, other links will work just fine.

4. Easy fault detection because the link can be easily identified.

5. It is easily expandable as new stations can be added to the open ports
on the hub.

6. Star topology networks are cost-effective as it uses inexpensive coaxial
cable

7. It supports a bandwidth of approx. 100Mbps. Ethernet 100BaseT is one
of the most popular Star topology networks



Disadvantages
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1. If the central hub or switch goes down, then all the

connected nodes will not be able to communicate with

each other.

2. Performance is based on the single concentrator i.e.

hub.

3. Hub requires more resources and regular maintenance

because it is the central system of star topology.



Bus Topology
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❑ Bus topology is a network type in which every computer and
network device is connected to single cable.

❑ Each node is either connected directly connected to the backbone
cable.

❑ When a node wants to send a message over the network, it puts a
message over the network. All the stations available in the network
will receive the message whether it has been addressed or not.

❑ The bus topology is mainly used in 802.3 (ethernet) and 802.4
standard networks.

❑ The configuration of a bus topology is quite simpler as compared to
other topologies.
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 The backbone cable is considered as a "single lane" through which the message is
broadcast to all the stations.

 The most common access method of the bus topologies is CSMA (Carrier Sense
Multiple Access).

 CSMA: It is a media access control used to control the data flow so that data
integrity is maintained, i.e., the packets do not get lost. There are two alternative
ways of handling the problems that occur when two nodes send the messages
simultaneously.

 CSMA-CD: CSMA CD (Collision detection) is an access method used to detect the collision.
Once the collision is detected, the sender will stop transmitting the data. Therefore, it
works on "recovery after the collision".

 CSMA-CA: CSMA CA (Collision Avoidance) is an access method used to avoid the
collision by checking whether the transmission media is busy or not. If busy, then the sender
waits until the media becomes idle. This technique effectively reduces the possibility of the
collision. It does not work on "recovery after the collision".



229



Advantages
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 If N devices are connected to each other in bus topology, then the

number of cables required to connect them is 1 ?which is known as

backbone cable and N drop lines are required.

 Coaxial or twisted pair cables are mainly used in bus-based

networks that support up to 10 Mbps.

 A failure in one node will not have any effect on other nodes.
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 A bus topology is quite simpler, but still it requires a lot of cabling.

 It requires specialized test equipment to determine the cable faults.

If any fault occurs in the cable, then it would disrupt the

communication for all the nodes.

 If two nodes send the messages simultaneously, then the signals of

both the nodes collide with each other.

 If the network traffic is heavy, it increases collisions in the network.

 Adding new devices to the network would slow down the network.



Ring Topology
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 Ring topology is like a bus topology, but with connected
ends.

 In ring topology, each host machine connects to exactly
two other machines, creating a circular network
structure.

 The node that receives the message from the previous
computer will retransmit to the next node.

 The data flows in one direction, i.e., it is unidirectional.
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 The data in a ring topology flow in a clockwise direction.

 The most common access method of the ring topology is
Token passing.

 Token passing: It is a network access method in which token is
passed from one computer to computer until it reaches the
destination.

 The sender modifies the token by putting the address along
with the data.

 The data is passed from one device to another device until the
destination address matches. Once the token received by the
destination device, then it sends the acknowledgment to the
sender.



Ring Topology
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 Easy to install.

 Does not require network server to manage the connectivity between

the computers and it is easier to add or remove a device from the

topology only two links are required to be changed.

 Performs better than a bus topology under heavy network load.



Disadvantages
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 One malfunctioning workstation or bad port can create problems for

the entire network.

 Modification of devices can affect the network.

 Network adapter card is more expensive than ethernet cards and

hubs.

 Much slower than an ethernet network under normal load.



Tree Topology
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 Tree topology combines the characteristics of bus topology
and star topology.

 A tree topology is a type of structure in which all the
computers are connected with each other in hierarchical
fashion.

 The top-most node in tree topology is known as a root node,
and all other nodes are the descendants of the root node.

 There is only one path exists between two nodes for the
data transmission. Thus, it forms a parent-child hierarchy.



Tree Topology
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Advantages
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 Tree topology is mainly used to provide broadband transmission,

i.e., signals are sent over long distances without being attenuated.

 Network is easily expandable.

 In tree topology, the whole network is divided into segments known

as star networks which can be easily managed and maintained.

 Error detection and error correction are very easy in a tree

topology.

 The breakdown in one station does not affect the entire network.



Disadvantages
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 Devices required for broadband transmission are very costly.

 Maintenance is difficult.

 Scalability of the network depends on the types of cables used.

 A tree topology mainly relies on main bus cable and failure in main

bus cable will damage the overall network.

 If new devices are added, then it becomes difficult to reconfigure.
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 Word Processing is the manipulation of character set, word, text, numbers,
sentences, and paragraphs in the document so that it is error free and looks
attractive.

 The work of preparing and formatting document was done manually with
the help of typewriter.

 A word processor is an application software for word processing, with a
word processing program, you can create letters, tables, newsletters, and
academic papers that are easy to revise.

 Word processor is a software package that enables you to create, edit,
print and save documents for future retrieval and reference.

 Word processors can create multiple types of files, including text files (.txt),
rich text files (.rtf), HTML files (.htm & .html), and Word files (.doc & .docx).
Some word processors can also be used to create XML files (.xml).



Word processing Softwares
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 Abiword (Free).

 Apple iWork.

 Corel WordPerfect.

 Google Docs (online and free).

 LibreOffice -> Writer (free).

 Microsoft Office -> Microsoft Word.

 Apache OpenOffice (free).

 Sun StarOffice (Free)

 LibreOffice Writer (Free)



Benefits of Word Processor
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 Book - Write a book.

 Document - Any text document that requires formatting.

 Help documentation - Support documentation for a product or service.

 Journal - Keep a digital version of your daily, weekly, or monthly journal.

 Letter - Write a letter to one or more people. Mail merge could also be used to automatically
fill in the name, address, and other fields of the letter.

 Marketing plan - An overview of a plan to help market a new product or service.

 Memo - Create a memo for employees.

 Report - A status report or book report.

 Résumé - Create or maintain your résumé.

 Calendars- Yearly calendar of various types.



Features of word processing
245

Text formatting - Changing the font, font size, font color, bold, italicizing,
underline, etc.

Copying, cutting, and pasting - Once text is entered into a document, it can
be copied or cut and pasted in the current document or another document.

Multimedia - Insert clip art, charts, images, pictures, and video into a
document.

Spelling and Grammar - Checks for spelling and grammar errors in a
document.

Adjust the layout - Capable of modifying the margins, size, and layout of a
document.

Find - Word processors give you the ability to quickly find any word or text in
any size of the document.
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 Search and Replace - You can use the Search and Replace feature to
replace any text throughout a document.

 Indentation and lists - Set and format tabs, bullet lists, and number lists.

 Insert tables - Add tables to a document.

 Word wrap - Word processors can detect the edges of a page or container
and automatically wrap the text using word wrap.

 Header and footer - Being able to adjust and change text in the header
and footer of a document.

 Thesaurus - Look up alternatives to a word without leaving the program.

 Multiple windows - While working on a document, you can have
additional windows with other documents for comparison or move text
between documents.
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 AutoCorrect - Automatically correct common errors (e.g., typing "teh" and having it 
autocorrected to "the").

 Mailers and labels - Create mailers or print labels.

 Import data - Import and format data from CSV, database, or another source.

 Headers and footers - The headers and footers of a document can be customized to 
contain page numbers, dates, footnotes, or text for all pages or specific pages of 
the document.

 Merge - Word processors allow data from other documents and files to be 
automatically merged into a new document. For example, you can mail merge 
names into a letter.

 Macros - Setup macros to perform common tasks.

 Collaboration - More modern word processors help multiple people work on the 
same document at the same time.



MS Word
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 Microsoft word is one of the most popular word processing
programs supported by both Mac and PC platforms.

 Microsoft word is used to create documents, brochures,
leaflets, outlines, resumes, lists and simple web pages.

 To begin Microsoft Word, goto Start→ Programs→Microsoft
Office → Microsoft Word. (or)

 Select Windows Key + R to obtain Run Command, there
type Winword and click Ok to start Microsoft Word.
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Title Bar
Menu Bar

Ruler
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Bullets and Numbering
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Inserting Tables

 Tables organize text into rows and columns, which can make the text
easy to type, edit, and format while spacing it correctly in your
document. Tables organize text into cells, where a cell is the intersection
of a row and a column.

 Word provides four ways to create a table:

 Click the Insert tab, click the Table icon, and then highlight the number of 
rows and columns for your table (up to a maximum of eight rows and ten 
columns).

 Use the Insert Table dialog box.

 Draw the size and position of the table with the mouse.

 Convert existing text (divided by a delimiter character such as a tab or a 
comma).
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Creating a table by highlighting rows and columns
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 Creating a table by highlighting rows and columns can
be fast, but it limits the size of your table to a maximum
of eight rows and ten columns. To create a table by
highlighting rows and columns, follow these steps:

1. Click the Insert tab.

2. Move the cursor where you want to insert a table in your
document.

3. Click the Table icon. A pull-down menu appears.

4. Move the mouse pointer to highlight the number of rows
and columns you want to create for your table.

5. When you highlight rows and columns, Word displays your
table directly in your document so you can see exactly
what your table will look like.

6. Click the left mouse button when you’re happy with the size
of your table.



Insert Table dialog box

 To create a table by defining a specific number of
rows and columns (up to a maximum of 63 columns),
follow these steps:

1. Click the Insert tab.

2. Move the cursor where you want to insert a table.

3. Click the Table icon. A pull-down menu appears.

4. Click Insert Table. The Insert Table dialog box
appears.

5. Click in the Number of Columns text box and type a
number between 1 and 63, or click the up or down
arrow to define the number of columns.

6. Click in the Number of Rows text box and type a
number or click the up or down arrow to define the
number of rows.
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In the AutoFit Behavior group, select one of the following radio

buttons:

 Fixed Column Width: Defines a fixed size for the column widths,

such as 0.3 inches

 AutoFit to Contents: Defines the width of a column based on the

width of the largest item stored in that column

 AutoFit to Window: Expands (or shrinks) the table to fit within

the current size of the document window

Click OK. Word draws the table in your document.
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Drawing a Table

 Drawing a table can be especially useful when
you want to place a table in the middle of a
page and create rows and columns of different
sizes.

 To draw a table in your Word document, follow
these steps:

1. Click the Insert tab.

2. Click the Table icon. A pull-down menu appears.

3. Click Draw Table. The mouse pointer turns into a
Pencil icon.
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 Move the mouse pointer where you want to draw your table, hold down the left

mouse button, and drag the mouse to draw your table.

 Word draws a rectangular dotted box to show where your table will appear.

 Release the left mouse button when you’re happy with the size and position of your

table.

 Draw the boundaries for your table’s rows and columns:

 To draw vertical lines in your table, move the mouse pointer to the top or bottom

of the table, hold down the left mouse button, and drag the mouse up and down.

 To draw horizontal lines in your table, move the mouse pointer to the left or right

side of the table, hold down the left mouse button, and drag the mouse right

and left to draw.
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 Press Esc or double-click to turn the mouse pointer from a Pencil

icon back to an I-beam pointer.

 If you need to draw new lines on a table later, click anywhere

inside that table, and the Table Tools Layout tab appears. Then

click the Draw Table icon to turn the mouse pointer into a Pencil

icon. Now you can draw new lines in your table.



Table in Word from existing text
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 If you have existing text that you’d like to turn into a table, you need
to first separate it into chunks so Word knows how to place the text
in individual cells in a table. To separate text, you need to use a
unique character such as

 Return (paragraph mark)

 Tab

 Comma.

 Other characters, such as the # or @ characters

 By using the same unique character to divide text, you can define
how you want Word to define how much text to display in each
individual cell of a table.
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 To convert existing text into a table, follow these steps:

1. Click the Insert tab.

2. Select the text that you want to convert into a table.

3. Click the Table icon. A pull-down menu appears.

4. Click the Convert Text to Table command. The Convert Text to
Table dialog box appears

5. Select a radio button in the Separate Text At group. Choose the
option that corresponds to the way you divided your text. So if
you divided your text by tabs, you would select the Tabs radio
button.

6. Click OK. Word converts your text into a table.
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Formatting and Coloring a Table

 After you create a table, you
can format individual cells
(spaces formed by the
intersection of a row and a
column) — or entire rows and
columns — by aligning text in
cells, resizing columns and
rows, and adding borders,
shading, or colors. All these
changes can make the text
inside the cells easier to read.
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Selecting all or part of a table

 Selecting all or part of a table in Word 2019

 To format and color a table, you must first select the table, row, column, or cell that

you want to modify. To select all or part of a table, follow these steps:

 Click in the table, row, column, or cell you want to modify. The Table Tools tab

appears.

 Click the Layout tab under the Table Tools heading.

 In the Table group, click Select. A pull-down menu appears.

 Choose an option, such as Select Row or Select Column. Word highlights your

chosen item in the table. At this point, you can choose a command to modify the

selected row or column (as when you choose a color or alignment).
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Aligning text in a Word table cell

 You can align text in a table cell in nine ways: top left (the default
alignment), top center, top right, center left, center, center right,
bottom left, bottom center, and bottom right.

 To align one or more cells, follow these steps:

 Click in the cell (or select multiple cells) that contains text you want to
align. The Table Tools tab appears.

 Click the Layout tab under the Table Tools heading.

 In the Alignment group, click an alignment icon such as Top Right or Bottom
Center.

 Word aligns your text. If you change the alignment of blank cells, any
new text you type in those blank cells will appear according to the
alignment you choose.
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Choosing a table style
279

 By coloring rows or columns and adding borders, you can customize the
appearance of your tables. However, it can be much faster to use a
predesigned table style instead, which can automatically format your text,
color rows, and add borders to your tables.

 To choose a table style, follow these steps:

 Move the cursor inside the table you want to modify.

 Click the Design tab under the Table Tools tab.

 In the Table Style Options group, select or clear check boxes, such as the Header
Row or Last Column check box.

 In the Table Styles group, click the More button. A pull-down menu of styles
appears. As you move the mouse pointer over a table style, Word displays a
live preview of your table formatted in the selected style.

 Click a table style. Word formats your table according to the style you chose.
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Resizing columns and rows
281

 You may need to resize a column or row in your table to expand or
shrink it so your text doesn’t appear crowded or surrounded by
empty space. You can resize a column or row by using the mouse or
by defining row heights and column widths.

 To resize a row or column with the mouse, follow these steps:

 Click anywhere inside the table you want to adjust, then move the mouse
pointer over the row or column border that you want to resize. The
mouse pointer turns into a two-way pointing arrow.

 Hold the left mouse button down and drag the mouse to resize the row
or column. Release the left mouse button when you’re happy with the size
of the row or column.
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 Using the mouse to resize a row or column can be fast, but if you
want to resize a row or column to a specific height or width, you can
type the specific dimensions by following these steps:

 Select the row, column, or table that you want to modify.

 If you select the entire table, you can adjust the width or height of rows
and columns for the entire table.

 Click the Layout tab under the Table Tools tab.

 Click the Width text box and type a value (or click the up or down
arrow to choose a value).

 Click the Height text box and type a value (or click the up or down
arrow to choose a value).



Inserting Pictures

 Pictures make our text more attractive and readable.
You can insert relevant pictures in your text by following
these steps;

 Place the cursor where you want to insert the picture

 Select the Insert tab on Ribbon

 In Illustrations group click the Picture command;

 It displays 'Insert Picture' dialog box

 Select the desired image

 Click Insert to insert the picture
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Inserting Images from the Web
286

 Place the cursor where you want to insert the picture

 Select the Insert tab on Ribbon

 In Illustrations group click the Picture command;

 Choose Insert→ Online Pictures.

 Click in the Office.com Clip Art search box, type poinsettia, and
press Enter. A selection of pictures that have poinsettia as a keyword
appear in the task pane.

 Scroll through the resulting clips.

 Click one of the clips and then click the Insert button to insert it.
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Insert Shapes

 Word comes with a library of common shapes ready to insert in a document. 
These include basic shapes, such as squares, circles, geometric figures, lines, 
and arrows — plus popular symbols. 

 Graphics professionals refer to these types of images as line art.

 To place some line art in a document, follow these steps:

 Click the Insert tab.

 In the Illustrations group, click the Shapes button.

 The button holds a menu that lists shapes organized by type.

 Choose a predefined shape.

 The mouse pointer changes to a plus sign (+).

 Drag to create the shape.

 The shape is placed into the document, floating in front of the text.
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 At this point, you can adjust the shape: Change its size, location, or colors.

 Use the Drawing Tools Format tab, conveniently shown on the Ribbon while
the shape is selected, to affect those changes.

 Instantly change the image by using the Shape Styles group on the Ribbon’s
Drawing Tools Format tab. Choose a new style from the Shape Gallery.

 Other items in the Shape Styles group affect the selected shape
specifically:

 Click the Shape Fill button to set the fill color;

 Use the Shape Outline button to set the shape’s outline color;

 Choose an outline thickness from the Shape Outline button’s menu, on the Weight
submenu;

 Use the Shape Effects button to apply 3D effects, shadows, and other fancy
formatting to the shape.
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Charts
291

 A chart is a tool you can use to communicate data graphically.

Including a chart in your document can allow your reader to see the

meaning behind the numbers, and it can make showing

comparisons and trends easier.

 Word has several types of charts, allowing you to choose the one

that best fits your data. In order to use charts effectively, you'll need

to understand how different charts are used.

 Word uses a spreadsheet as a placeholder for entering chart data,

much like Excel. The process of entering data is fairly simple,



Adding charts to Word
292

 Microsoft Word enables adding charts and graphs of many kinds in
your document, from simple pie charts to 3D surface graphs. To do
this, simply:

1. Place the cursor where you want your chart to appear

2. Go to “Insert” on the main ribbon and select “Chart” from the
“Illustrations” section

3. In the new window, pick the type of chart you want in your document
and click “OK”

4. Your chart will now appear in the position selected and an Excel
spreadsheet window will open (called “Chart in Microsoft Word”)

5. Edit the values and labels in the Excel window to reflect the data
required for your chart
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To change the chart layout:
295

 Word's predefined chart layouts allow you to modify chart
elements—including chart titles, legends, and data labels—to make
your chart easier to read.

 Select the chart you want to modify. The Design tab will appear.

 From the Design tab, click the Quick Layout command.

 Select the desired predefined layout from the menu that appears.

 The chart will update to reflect the new layout.

 To change a chart element (such as the chart title), click the element
and begin typing.



Adding Equations to Word
296

 To insert equations in Word from one of the preset equations,

 First place your cursor at the insertion point in your document where
you want the equation to appear.

 Then click the “Insert” tab in the Ribbon. At the right end of the tab
is the “Symbols” button group. Click the drop-down arrow on the
“Equation” button in this button group to then open the menu of
choices.

 Scroll through the “Built-In” section to view the available preset
equations.

 After finding the preset equation to insert, then click it in either of
these areas to insert it into your document.



297

 Alternatively, it is possible to insert equations in Word by manually

entering an equation.

 To manually insert an equation, first place your cursor at the

insertion point in your document where you want the equation to

appear.

 Then click the “Insert” tab in the Ribbon.

 Then click the “Equation” button in the “Symbols” button group.

 A blank equation is then inserted into your document.
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 The “Equation Tools” contextual tab then appears, with the “Design” tab
selected.

 We can use the “Symbols” and “Structures” button groups, in conjunction
with your keyboard, to then enter your desired equation into the equation
field.

 After inserting equations in Word using either option, click the drop-down
arrow in the equation field to see a menu of options.

 Selecting the “Save as New Equation…” option from the menu adds the
equation to the drop-down menu of the “Equation” button.

 It is possible to choose how the equation looks by selecting the
“Professional” or “Linear” options.
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 The next options, “Change to Inline” or “Change to Display,”
set how to insert the equation into the document.

 Selecting “Display” lets you adjust the equation’s justification
by using the options in the drop-down menu under the
“Justification” option.

 Selecting “Inline” locks the equation to its original insertion
point.

 To delete an equation, select it in your document. Then press
the “Delete” or “Del” key on your keyboard.
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Microsoft Excel: Spread Sheet
303

 MS-Excel is a window based powerful spreadsheet (Worksheet) package.

 Spreadsheet is wonderful analysis tool with automatic recalculation.

 Banking system, payroll system, Sales and stock maintenance also made in

the MS-Excel spreadsheet.

 A spreadsheet is basically a large grid that is separated into rows and

columns.

 Easy evaluation, What if analysis, Chart and report creations are one of

the tools in the MS-Excel.

 Microsoft Excel is a spread sheet program that allows you to perform

various calculations, estimations, and formulations with data.
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 It is the electronic counter part of a paper ledger sheet which
consists of a grid of columns and rows.

 The total number of rows in excel is 65,536 and min is 256.

 The row is identified by alphabets like A, B,C etc. The column is
identified by numbers or digits.

 It provides various facilities like:

 Inserting charts

 Creating graphs

 Analyzing situations

 Help in decision-making



Features of Excel or Spreadsheet 
305

 Special mathematical, trigonometric, financial and statistical functions are
available. All complicated calculations can be performed vary easily using
these functions.

 The result of a calculations can be accurate.

 Data can also be viewed in the form of graphs.

 The information stored in a worksheet can be transferred to other software
program.

 The entire worksheet or any part, it can be printed in desired format.

 The worksheet is saved can be retrieved and modified later as when
required.



Starting Excel
306

 Click on the start button on the Taskbar.

 To begin Microsoft Excel , goto Start→ All Programs→Microsoft Office → Microsoft

Excel. (or)

 Select Windows Key + R to obtain Run Command, there type Excel and click Ok to

start Microsoft Excel.

 The following excel window displayed on the screen.
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 Creating a Workbook

 Creating a workbook: Menu option

 Creating a workbook: Toolbar option.

 Opening an existing workbook

 Saving workbook

 Closing a workbook

 Components of an Excel Windows
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Title BarName Bar

Row Header

Active Cell

Column Header

Formula Bar

Sheet Scrolls
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 Working with Worksheet

 Entering the Data (Text, Numeric, Logical, Formulas)

 Editing the Cell content.

 Working with rows and Columns

◼ Adjusting Row Height and Column Width

◼ Inserting Rows and Columns

◼ Deleting Rows and Columns

◼ Moving Rows and Columns

◼ Copying Rows and Columns

 Printing in Excel

 Hiding Columns
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 Organizing Worksheets

 Inserting Worksheets

Moving Worksheets

 Copying Worksheets

 Deleting Worksheets

 Renaming Worksheets

 Charts in Excel



Charts in Excel
312

 Excel provides you different types of charts that suit your purpose. Based on the type of data, you can 
create a chart. You can also change the chart type later.

 Excel offers the following major chart types −

 Column Chart

 Line Chart

 Pie Chart

 Doughnut Chart

 Bar Chart

 Area Chart

 XY (Scatter) Chart

 Bubble Chart

 Stock Chart

 Surface Chart

 Radar Chart

 Combo Chart
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 Column Chart: A Column Chart typically displays the categories
along the horizontal (category) axis and values along the vertical
(value) axis. To create a column chart, arrange the data in columns
or rows on the worksheet.

 Line Chart : Line charts can show continuous data over time on an 
evenly scaled Axis. Therefore, they are ideal for showing trends in 
data at equal intervals, such as months, quarters or years.

 In a Line chart −
 Category data is distributed evenly along the horizontal axis.

 Value data is distributed evenly along the vertical axis.
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 Pie Chart :Pie charts show the size of items in one data series, proportional to the

sum of the items. The data points in a pie chart are shown as a percentage of the

whole pie. To create a Pie Chart, arrange the data in one column or row on the

worksheet.

 Doughnut Chart: A Doughnut chart shows the relationship of parts to a whole. It is

similar to a Pie Chart with the only difference that a Doughnut Chart can contain

more than one data series, whereas, a Pie Chart can contain only one data series. A

Doughnut Chart contains rings and each ring representing one data series. To create

a Doughnut Chart, arrange the data in columns or rows on a worksheet.

 Bar Chart : Bar Charts illustrate comparisons among individual items. In a Bar Chart, 

the categories are organized along the vertical axis and the values are organized 

along the horizontal axis. To create a Bar Chart, arrange the data in columns or 

rows on the Worksheet.
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 Area Chart: Area Charts can be used to plot the change over time and draw attention to the
total value across a trend. By showing the sum of the plotted values, an area chart also shows
the relationship of parts to a whole. To create an Area Chart, arrange the data in columns or
rows on the worksheet.

 XY (Scatter) Chart

 XY (Scatter) charts are typically used for showing and comparing numeric values, like scientific,
statistical, and engineering data.

 A Scatter chart has two Value Axes −

 Horizontal (x) Value Axis

 Vertical (y) Value Axis

 It combines x and y values into single data points and displays them in irregular intervals, or
clusters. To create a Scatter chart, arrange the data in columns and rows on the worksheet.

 Place the x values in one row or column, and then enter the corresponding y values in the
adjacent rows or columns.
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 Bubble Chart : A Bubble chart is like a Scatter chart with an additional third column
to specify the size of the bubbles it shows to represent the data points in the data
series.

 Stock Chart: As the name implies, Stock charts can show fluctuations in stock prices.
However, a Stock chart can also be used to show fluctuations in other data, such as
daily rainfall or annual temperatures.

 Surface Chart: A Surface chart is useful when you want to find the optimum
combinations between two sets of data. As in a topographic map, colors and
patterns indicate areas that are in the same range of values.

 Radar Chart: Radar charts compare the aggregate values of several data series.
To create a Radar chart, arrange the data in columns or rows on the worksheet.

 Combo Chart: Combo charts combine two or more chart types to make the data
easy to understand, especially when the data is widely varied. It is shown with a
secondary axis and is even easier to read. To create a Combo chart, arrange the
data in columns and rows on the worksheet.
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 Consider the following Data, 

STUDENT NAME U5CS01MT U5CS02MT U5CS03ET U5CS05ST U5CS01MP U5CS02MP

PRASANTH .A
35 45 10 25 60

30

PRAVEEN KUMAR .M
11 76 79 86 84 31

PRIYANKA .P
28 96 54 60 81

40

RAGHUL .J
91 24 74 24 59

28

ROKESH .P
46 76 64 82 46

32

SHARAN .V
57 74 48 19 59

35

SINDHU .P
60 71 52 32 66

36
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Multimedia 
320

 Multimedia is a combination of text, graphics, images, audio, video and
animation.

 Multimedia as name suggests is the combination of Multi and Media that is
many types of media (hardware/software) used for communication of
information.

 Multimedia is characterized by an audio-visual interface, which provides an
excellent medium for user interactivity.

 It improves information retention.

 Computer games are the most common applications of multimedia.

 Multimedia also become an integral part of the internet. Web pages can
contain animated images.
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Applications of Multimedia
322

 Following are the common areas of applications of multimedia.

 Multimedia in Business:

 The business application of multimedia includes, product demos, instant messaging.

 Multimedia is used in business for training employees using projectors, presenting

sales, educating customers etc.

 It helps for the promotion of business and new products.

 One the excellent applications is voice and live conferencing.

 A multimedia can make a audience come live.
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 Multimedia in Hospital-

 Multimedia best use in hospitals is for real time monitoring of conditions of patients in

critical illness or accident.

 The conditions are displayed continuously on a computer screen and can alert the

doctor/nurse on duty if any changes are observed on the screen.

 Multimedia makes it possible to consult a surgeon or an expert who can watch an ongoing

surgery line on his PC monitor and give online advice at any crucial juncture.

 In hospitals multimedia can also be used to diagnose an illness with CD-ROMs/ Cassettes/

DVDs full of multimedia based information about various diseases and their treatment.

 Some hospitals extensively use multimedia presentations in training their junior staff of

doctors and nurses. Multimedia displays are now extensively used during critical surgeries.
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 Multimedia in Entertainment:

 Multimedia is heavily used in the entertainment industry, especially to develop special

effects in movies and animations (VFX, 3D animation, etc.).

 Multimedia games are a popular pastime and are software programs available either as

CD-ROMs or online.

 Some video games also use multimedia features.

 Multimedia applications that allow users to actively participate instead of just sitting by as

passive recipients of information are called interactive multimedia.
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 Education:

 In Education, multimedia is used to produce computer-based training courses
(popularly called CBTs) and reference books like encyclopedia.

 A CBT lets the user go through a series of presentations, text about a particular
topic, and associated illustrations in various information formats.

 Edutainment is an informal term used to describe combining education with
entertainment, especially multimedia entertainment.

 Engineering:

 Software engineers may use multimedia in Computer Simulations for anything
from entertainment to training such as military or industrial training.

 Multimedia for software interfaces are often done as collaboration between
creative professionals and software engineers.
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 Industry:

 In the Industrial sector, multimedia is used as a way to help present information
to shareholders, superiors and coworkers.

 Multimedia is also helpful for providing employee training, advertising and
selling products all over the world via virtually unlimited web-based
technologies.

 Mathematical and Scientific Research:

 In Mathematical and Scientific Research, multimedia is mainly used for modeling
and simulation.

 For example, a scientist can look at a molecular model of a particular substance
and manipulate it to arrive at a new substance.

 Representative research can be found in journals such as the Journal of
Multimedia.



Elements of Multimedia
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 The various elements of multimedia are as follows:

 Text

 Images

 Sound / Audio

 Video



Text
328

 Text usually contains words and symbols. It is the most common form of Communication.

Usually text provides the core structure to the package.

 Using Text in Multimedia

 Text in multimedia applications can be

o Page titles

o Labels and pictures

o Delivering information in the form of multiple sentences and paragraph.

❑ Text technology is based on creating letters and numbers, special characters to build

words, sentences and paragraph of information.
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❑ Text elements fall into the following categories.

❑ Alphabet characters

❑ Numbers

❑ Special characters

❑ Although multimedia products include pictures audio and video, text may be the

most common data type found in these applications.



Image
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 A graphic, or graphical image, is a digital representation of non-text
information such as a drawing, chart, or photo.

 Pictorial representation that are created by the primitive objects such as
lines, polygons, circles, curves and arcs.

 Many Web pages use colorful graphical designs and images to convey
messages.

 Graphics are the backbone of any multimedia product.

 Graphics in the form of pictures, clip art, photographs and line art are used
to provide backgrounds, informational content and navigational controls for
multimedia products.

 Graphics are created using a variety of tools including paint, drawing
software, image scanners and digital camera.
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 Graphics are stored in files in a variety of formats and sizes.

 There are two types of Graphics:

 Bitmap images- Bitmap images are real images that can be captured from devices such
as digital cameras or scanners. Generally bitmap images are not editable. Bitmap images
require a large amount of memory.

 Vector Graphics- Vector graphics are drawn on the computer and only require a small
amount of memory. These graphics are editable.

 Image File Formats : The various image files formats are as follows:

 JPEG— Joint Photographic Expert Group

 BMP — Bit Map File

 GIF — Graphical Interchange File Format

 PNG — Portable Network Graphics

 TIFF — Tagged Image File Format



Animation
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 Animation- Animation is a process of making a static image look like it is

moving.

 An animation is just a continuous series of still images that are displayed in a

sequence.

 The animation can be used effectively for attracting attention.

 Animation also makes a presentation light and attractive.

 Animation is very popular in multimedia application.



Audio
333

 A multimedia application may require the use of speech, music and
sound effects. These are called audio or sound element of
multimedia.

 Speech is also a perfect way for teaching.

 Audio are of analog and digital types.

 Analog audio or sound refers to the original sound signal.

 Computer stores the sound in digital form.

 Therefore, the sound used in multimedia application is digital audio.



334

 The various audio file formats are as follows:

 MP3 –

 It stands for MPEG-1 Audio Layer 3. It was released in 1993 and became popular. It is most
popular audio format for music files. Main aim of MP3 is to remove all those sounds which not
hearable or less noticeable by humans ears. Hence making size of music file small. MP3 is like
universal format which is compatible almost every device.

 AAC –

 It stands for Advanced Audio Coding. It was developed in 1997 after MP3.The compression
algorithm used by AAC is much more complex and advanced than MP3, so when compared a
particular audio file in MP3 and AAC formats at the same bitrate, the AAC one will generally
have better sound quality. It is the standard audio compression method used by YouTube,
Android, iOS, iTunes, and PlayStations.
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 WMA – It stands for Windows Media Audio. It was released in 1999.It was
designed to remove some of the flaws of MP3 compression method. In
terms of quality it is better than MP3. But is not widely used.

 WAV – It stands for Waveform Audio File Format, it was developed by
Microsoft and IBM in 1991. It is just a Windows container for audio formats.
It is compatible with both Windows and Mac.

 AIFF –It stands for Audio Interchange File Format. It was developed by
Apple for Mac systems in 1988. Like WAV files, AIFF files can contain
multiple kinds of audio. It is compatible with both Windows and Mac.

 Audio includes speech, audio effects, ambient sound(For example,
background sound of the sea) and music.



Video
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 Video- The term video refers to the moving picture, accompanied by
sound such as a picture in television.

 Video element of multimedia application gives a lot of information
in small duration of time.

 Digital video is useful in multimedia application for showing real life
objects.

 Video have highest performance demand on the computer memory
and on the bandwidth if placed on the internet.

 Digital video files can be stored like any other files in the computer
and the quality of the video can still be maintained. The digital
video files can be transferred within a computer network. The digital
video clips can be edited easily.
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 The various audio file formats are as follows:

 Flash Video Format (.flv): This video format is very popular due to the

availability of flash player for cross platform. These video files are supported

by almost every browser making suitable for web. This format is compact and

support progressive and streaming download. Some users of this format are

Youtube, Yahoo! Video, VEVO etc.

 AVI format (.avi): Audio Video Interleave which can contain both audio and

video data. It was developed by Microsoft. It uses less compression can contain

almost any codecs. It is popular among internet user due to multiple codecs

support. All windows OS support this format including another player for other

platform exist.
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 MP4 (.mp4) : This format is used to store to store audio and video stream online. MP4
file format was created by Moving Picture Experts Group (MPEG) as a multimedia
container format store audio visual data. It used different compression technique for
video and audio.

 WMV (Windows Media Video): This format was developed by Microsoft. It was
designed for web streaming applications. WMV files are the very small in size over the
Web, as their file size decreases after compression, due to which results in poor video
quality. But this make it only file format which can be send through e-mail.

 QuickTime Format (.mov): This format was developed by Apple. It can store multiple
tracks(for different language), text file(subtitle) and effects. MOV files are of high
quality and are usually big in file size. It is supported both by Windows and Apple.

 3GP (.3gp): This is both audio and video file format which was designed to transmit
data between 3G phones and the internet. It is most commonly used to capture video
from the phone and upload it online. Both Windows and Mac support the format.



Desktop Publishing Basics
339

 Desktop publishing is the use of the computer and software to create visual

displays of ideas and information.

 Desktop publishing documents may be for desktop or commercial printing or

electronic distribution, including PDF, slideshows, email newsletters, electronic

books, and the Web.

 Desktop publishing is a term coined after the development of a specific type of

software. It's about using that software to combine and rearrange text and

images and creating digital files for print, online viewing, or websites.

 Before the invention of desktop publishing software, the tasks involved in

desktop publishing were done manually by people who specialized in graphic

design, typesetting, and prepress tasks.



Things You Can Do With Desktop Publishing
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With desktop publishing software and hardware you can:

 Design print communications such as brochures, fliers, ads, and posters.

 Design print communications such as catalogs, directories, and annual 
reports.

 Design logos, business cards, and letterhead.

 Design and publish newsletters, magazines, and newspapers.

 Design books and booklets.

 Convert print communications to formats for the web and smart devices 
such as tablets and phones.

 Create resumes and business forms including invoices, inventory sheets, 
memos, and labels.

 Self-publish books, newsletters, and e-books.
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 Design and publish blogs and websites.

 Design slides shows, presentations, and handouts.

 Create and print greeting cards, banners, postcards, candy wrappers, 
and iron-on transfers.

 Make digital scrapbooks and print or digital photo albums.

 Create decorative labels, envelopes, trading cards, calendars, and 
charts.

 Design store signs, highway signs, and billboards.

 Take work designed by others and putting it into the correct format for 
digital or offset printing or for publishing online.

 Create more attractive, readable reports, posters, and print or on-
screen presentations for school or business.
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 Adobe FrameMaker

 Adobe Illustrator

 Adobe PageMaker

 Adobe Photoshop

 Coreldraw

 LibreOffice Impress

 LibreOffice Writer

 Microsoft PowerPoint

 Microsoft Publisher

 Microsoft Word



Page Layout Programs
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 Page layout is the part of graphic design that deals in the
arrangement of visual elements on a page.

 Page formatting is the layout of the page when it is printed on a
printer. It includes page size, page orientation, page margins,
headers and footer etc.

 Page formatting is defined in page setup dialog box

 Use the following steps:

 Choose Page setup from File menu(File Page Setup) Short cut: Alt+F+U

 Set the paper size, page orientation, margins, print preview and printing
a document.



Page Size
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 The height and the width of the page on which matter (text and graphics) are
printed is called the size of the page.

 Page size of document is defined in the Page Setup from the File menu. To define
page size:

 Click File Menu and select Page Setup command.

 Select Paper Size tab and select appropriate page size from a list of given standard
sizes.

 Some standard page sizes and their dimensions are as follows:

 Letter: with paper size of 8.5 by 11 inches

 Legal: with paper size of 8.5 by 14 inches

 A4:with paper size of 8.27 by 11.69 inches

 Executive :with paper size of 7.25 by 10.5 inches

 Custom size: Any dimensions can be given.
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 Page Orientation: 

 Orientation refers to whether 
the text is to printed length 
wise or width-wise. 

 When the text is printed or 
typed length-wise this is 
called Portrait Page 
Orientation.

 When the text is printed or 
typed width wise. this is called 
Landscape Page Orientation. 

346
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 Margins: Margin is the distance from the text of the paper's edge.

 Ruler line in a word processor displayed the position of margins.

 The Margins are different types.

 Left Margin — This is the distance between the text and the left edge of the
paper.

 Right margin — This is the distance between the text and the right edge of the
paper.

 Top Margin — This is the distance between the text and the top edge of the
paper.

 Bottom Margin — This is the distance between the text and the bottom edge of
the paper.
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 Print Preview

 Before you print a document, you should view it to get an idea as to how will

look when printed.

 This can be done through Print Preview.

 To start a preview of the document before printing.

 Click the print preview button on the Standard Toolbar.

 Or choose Print preview form File menu ( File →Print Preview)

 Shortcut Alt+ F+V



349



Text Generation 
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 From a design perspective, the choice of font size, style and text attributes
need to be related both to the complexity of the message and to its venue.

 Some useful tips for designing the text in your multimedia application

 Use legible fonts that can be easily read.

 Vary the font size and style according to the importance of message.

 Indent your paragraph wherever required.

 Explore the effects of different colors and shadows to add depth to your
applications.

 Use menus for easy navigation and meaningful words for menu items.

 Use buttons, icons or symbols for user interaction.



Graphics for DTP 
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 Graphics is a generic term used to describe the pictorial representation of data.

 Pictorial representations that are created by the primitive objects such as lines,

polygons, circles, curves, and arcs.

 Graphics are the backbone of any multimedia product.

 Graphics in the form of pictures, clip art, photographs and line art are used to

provide backgrounds, informational content navigational controls for multimedia

products.

 Graphics are created using a variety of tools including paint drawing software,

image scanners and digital camera.

 Graphics are stored in files in a variety of formats and sizes.



Print Production 
352

 A major parts of any word processing software is to print document.

 To print a document, you can specify which printer to use and how many copies to print.

 To print a document use the follow step:

 Choose print from File menu(File → Print) Or

 Click Print icon from the standard toolbar

 Short Cut: Ctrl + P / Alt+F+P

 This dialog box allows you to select the number copies and how many pages of the document, you
want to print. You can specify the range the document to print by choosing:

 All — To print all the pages in the document.

 Current Page — To print the current page in the document

 Pages — To print certain number of pages.

 Number of Copies — It allows you to enter the number of copies you want to print.

 Pages per Sheet — It offers you to select the number of pages in the document that you want to print on each
sheet of paper.
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 Internet is a network of network that connect computers all

over the world.

 Network is an interconnection of systems to share data and

information.

 Internet is a collection of government, academic, commercial,

individual and other sites.



History of Internet
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 In 1969,Department of Defense (DoD) USA created a small
network of four computers called ARPANET (Advanced
Research Projects Agency Network).

 This Network was setup for the military purpose.

 The Primary goal of ARPANET was to allow multiple users to
send and receive information simultaneously over the
communication path.

 The Network operated with a technique called packet
switching using TCP.
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 The ARPANET was successful, and many universities joined
the network.

 This ARPANET was divided into two parts MILNET and
ARPANET.

 MILNET was used for military related sites and ARPANET for
non-military related sites.

 These two networks were connected together by Internet
Protocol (IP).

 The combined set of protocol is called TCP/IP.
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 During the 1970’s networks like BITNET and USENET

came into being.

 Around 1980’s NSFNET (National Science

Foundation Network) was created.

 In 1984, NSF designed a high-speed successor to

the ARPANET for all university research groups.



Internet Services
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 E-mail: This service has been available since the early days of the ARPANET

and its enormous popular. Email enables people to send messages as well as

files to one or more people.

 Mailing Lists: enables groups of people to conduct group conversations by

email.

 News: Usenet Newsgroups are specialized forums in which users with common

interest can exchange messages. It enables online group discussions to occur,

using a system of news server to store messages of 10,000.

 Remote login: Users on the internet can log into any other machine on the

internet on which they have account.

 File Transfer: Users can copy files from one machine on the internet to another.
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 Online Chat- Provides a way for real time online chatting to occur, where

participants read each other messages.

 Voice and Video Conferencing: Two or more people to hear and see each

other, with the help of camera fixed over these and share other applications.

 Internet Telephony (VoIP): Allows the internet users to talk across internet to

any PC equipped to receive the call.

 Browser: Contains the basic software that can retrieve, view and send

information over the internet.

 Download: To copy data from a remote computer to the local computer.

 Upload: To send data from local computer to remote computer.



Internet Terminologies
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 Client: A client is any computer on the network that requests
services from another computer on the network. To be able
to request services and access the resources present on some
other computer on the network, the client should have
adequate access permissions.

 Server: A server is a computer that receives requests from
client computers, process these requests and send the output
to the respective client computers that had placed requests.
The range of services that a server can offer a client is
based on the permissions possessed by the client. The server
computer defines these permissions.



Client-Server Network
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 Client-Server Network is one of the most basic architecture
that is used for computer connectivity.

 In this type of network, several client computers are
connected to the server and also to each other.

 Client computers request services from the server computer,
and the server accepts/rejects these requests.

 The server computer is also responsible for storing relevant
information that is frequently used by the client.



Web Server.
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 A Web Server is a computer that is dedicated to provide
web services to clients on the internet.

 A Web server is a dedicated computer that uses HTTP
(Hypertext Transfer Protocol) and other protocols to respond
to client requests made over the World Wide Web.

 The main job of a web server is to display website content
through storing, processing and delivering webpages to
users.

 Basically web server is used to host the web sites but there
exists other web servers also such as gaming, storage, FTP,
email etc.



Internet Service Provider (ISP)
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 Internet services typically provided by ISPs can include
Internet access, Internet transit, domain name registration,
webhosting, Usenet service, and colocation.

 ISP’s are companies that help users connect to the internet
for a monthly fee. In return, they provide a username and
password and a telephone number.

 The username and password are used to authenticate the
user on the internet.

 Some of the ISP are Hathway, Railwire, JIO, Airtel,
Vodafone, BSNL, etc.,



Modem
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 To access the internet, a user requires a hardware device called a
Modem.

 The word Modem originated from the word's modulator and
demodulator.

 A modem transmits data over telephonic lines as analog signals and
then converts them to digital signals that can be interpreted by a
computer.

 The sending modem modulates the data into a signal that is
compatible with the phone line, and the receiving modem
demodulates the signal back into digital data.
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 A web page is a simple document displayable by a browser. Such documents are

written in the HTML language.

 A Web page may be Static or Dynamic. Static pages show the same content each

time they are viewed. Dynamic pages have content that can change each time they

are accessed. These pages are typically written in scripting languages such as PHP,

Perl, ASP, or JSP.

 Collection of web pages is called as website.

 Web development is the work involved in developing a Web site for the Internet or

an intranet. Web development can range from developing a simple single static

page of plain text to complex Web-based Internet applications, electronic

businesses, and social network services.



Web Hosting
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 Web hosting is a service of providing online space for storage of

web pages. These web pages are made available via World

Wide Web. The companies which offer website hosting are

known as Web hosts.

 The servers on which web site is hosted remain switched on 24

x7. These servers are run by web hosting companies. Each server

has its own IP address. Since IP addresses are difficult to

remember therefore, webmaster points their domain name to the

IP address of the server their website is stored on.



Domain Name System
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 The Domain Name System (DNS) is the phonebook of the
Internet. DNS translates domain names to IP addresses so
browsers can load Internet resources.

 A domain name is a unique name associated with a specific IP
address by a program that runs on an Internet host computer.

 This program, which coordinates the IP addresses and domain
names for all computers attached to it, is called DNS (Domain
Name System).

 Domain names are case insensitive so com and COM mean the
same thing.
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 DNS is divided into two categories:

 Generic Top Level Domain(gTLD)

 Country code Top Level Domain(ccTLD)

Generic Top Level Domain (gTLD)

 There are seven domains within the generic top-level domal (gTLD).

 They .com, .org, .net, .gov, .mil, . edu, .int.

 The .com, .org, of .net are open domains and anyone can register their names
within the domains.

 .edu is restricted to individuals register

 . gov is restricted to u by government agencies and its employees

 and mil is restricted to u military.
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.biz Business of all sizes

.com commercial organizations, businesses and companies

.org organisation site (non-profits, etc.)

.net Network providers or commercial companies

.edu educational site (universities, schools, etc.)

.gov government organizations

.info Business organizations of individuals providing general information's.

int organizations established by international treaty

.mil military site

.pro Certified professionals such as doctors, lawyers and accountants.



Country code top- level domains (ccTLD) 
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 Country code top- level domains (ccTLD) are two letter designations assigned to

individual countries.

 Each country linked to the Web has a two letter top-level domain, for example .fr is

France, .ie is Ireland, in is India etc.

 Presently there are close to 250 such ccTLDs one for each country in the world.

 The registration process for sites with the ccTLDs slightly different from that using

the gTLDs.

 The registration can be assigned through one of the several registrars accredited

with The Internet Corporation for Assigned Names and Numbers(ICANN).

 ICANN currently accredits domain-name registrars for the following country code

top level domain (ccTLD).



372



Uniform Resource Locator (URL)
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 Every Web page has a unique address called a URL
(Uniform Resource Locator) which identifies where it is
located on the Web.

 For example, the URL for APCAS home page is:
http://www.apcas.in/home/

 The basic parts of a URL often provide "clues" to where a
web page originates and who might be responsible for the
information at that page or site.

 URLs have three basic parts: the protocol, the server name
and the resource ID.

http://www.apcas.in/home/


374

 Look again at APCAS's URL below to see these three parts.

 The protocol is shown at the beginning of the URL before the double slash
(//); the server name is between the double slash (//) and the first single
slash (/); and the resource id is everything after the first single slash(/).

http://www.apcas.in/home/

protocol |Server Name |resource id

 Let's examine each part of this URL:

First part: protocol (http://)

 The protocol identifies the method (set of rules) by which the resource is
transmitted. All Web pages use Hypertext Transfer Protocol (HTTP). Thus, all
web URL's begin with http://.
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 Second Part: Server Name

 The server name identifies the computer on which the resource is
found.

 This part of the URL commonly identifies which company, agency or
organization may be either directly responsible for the information,
or is simply providing the computer space where the information is
stored.

 Web server names often begin with the letters www, but not always.

 The server name always ends with a dot and a three-letter or two-
letter extension called the domain name.
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 The domain is important because it usually identifies the
type of organization that created or sponsored the
resource. Sometimes it indicates the country where the server
is located.

 The most common domain names are:

 .com which identifies company or commercial sites

 .org for non-profit organization sites

 .edu for educational sites

 .gov for government sites

 .net for Internet service providers or other types of networks.
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 If the domain name is two letters, it identifies a country, e.g. .us for the

United States,

 .uk for the United Kingdom,

 .au for Australia,

 .mx for Mexico or

 .ca for Canada.

 The server name for our college website is: www.apcas.in. The server name

may also be the name of a website.

 Websites can be either all of the pages on one server(computer) or all of

the pages under a specific sub directory on a server.

http://www.apcas.in/
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 Third part: resource ID (home/)

 The resource ID is the name of the file for the page and any
directories or subdirectories under which it is stored on the specified
computer.

 The resource ID for our College's homepage is: /home.htm. (A
"homepage" is the opening or main page for any web site that
provides links to all of the other pages on the site.)

 The part of the resource ID after the last slash (/) is the file name for
the specific page or other resource.

 The file name ends with a three or four letter designation that
specifies the file type (e.g., .htm or .html for A standard Web page,
.jpg or .gif for common graphic files.)



Hypertext
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 Hypertext is text which contains links to other texts.

 Hypertext is text displayed on a computer display
or other electronic devices with references to other
text that the reader can immediately access.

 Hypertext documents are interconnected by
hyperlinks, which are typically activated by a
mouse click, keypress set or by touching the screen.



Hypermedia
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 Hypermedia is an extension of the term hypertext.

 Hypermedia is a nonlinear medium of information that
includes graphics, audio, video, plain text and hyperlinks.

 The term was first used in a 1965 article written by Ted
Nelson.

 The World Wide Web is a classic example of hypermedia.

 The most common type of hypermedia is an image link.
Photos or graphics on the Web are often linked to other
pages.



HTTP
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 Hypertext Transfer Protocol(HTTP) is an internet standard or
set of rules that allows the exchange of information on the
World Wide Web.

 HTTP defines how messages are formatted and transmitted
and what actions Web servers and browsers should take in
response to various commands.

 For example, when anyone enter a URL, in browser, this
actually sends an HTTP command to the Web server
directing it to fetch and transmit the requested Web page.
Sending and receiving messages can be done through HTTP.



Working of the Internet
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 The internet works on a Client-server approach. Whenever
the user wants to retrieve a webpage, the internet works as
follows:

 A user enters the URL of the webpage in the address bar of the
web browser.

 The web browser requests the Domain Name Server for the IP
address corresponding to www.google.com.

 After receiving the IP address, the browser sends the request for
the webpage to the Internet using HTTP protocol which specific
the way the browser and Web Server communicates.

http://www.google.com/
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 The Internet Routers send the request to the intended web

server.

 Then the web server receives the request using HTTP

protocol. It then examines the hard disk or memory and if

the requested file is found it returns it back to the web

browser and closes the Http connection.

 The Web browser then interprets the file and displays

contents of the webpage in the browser window.
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 Internet Protocol defines a universal addressing called IP Address. An

Internet Protocol address (IP address) is a numerical label assigned to each

device connected to a computer network that uses the Internet Protocol for

communication.

 An IP address serves two main functions: host or network interface

identification and location addressing.

 IP addresses are written and displayed in human-readable notations, such

as 172.16.254.1 in IPv4, and 2001:db8:0:1234:0:567:8:1 in IPv6.

 Network administrators assign an IP address to each device connected to a

network. Such assignments may be on a static or dynamic basis, depending

on network practices and software features.
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 The IP address space is managed globally by the Internet Assigned

Numbers Authority (IANA), and by five regional Internet registries

(RIRs) responsible in their designated territories for assignment to

local Internet registries, such as Internet service providers (ISPs), and

other end users.

 Internet Protocol version 4 (IPv4) defines an IP address as a 32-bit

number. However, because of the growth of the Internet and the

depletion of available IPv4 addresses, a new version of IP (IPv6),

using 128 bits for the IP address, was standardized in 1998.
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 An IP address serves two principal functions.

 It identifies the host, or more specifically its network
interface, and it provides the location of the host in the
network, and thus the capability of establishing a path to
that host.

 Its role has been characterized as follows:

 "A name indicates what we seek.

 An address indicates where it is.

 A route indicates how to get there."

 The header of each IP packet contains the IP address of the
sending host, and that of the destination host.
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 Email is a service which allows us to send the message in electronic mode over the
internet. It offers an efficient, inexpensive and real time mean of distributing
information among people.

 Each user of email is assigned a unique name for his email account. This name is
known as E-mail address. Different users can send and receive messages according
to the e-mail address.

 E-mail is generally of the form username@domainname. For example,
apcasgbn19@rediffmail.com is an e-mail address where apcasgbn19 is username
and rediffmail.com is domain name.

 The username and the domain name are separated by @ (at) symbol.

 E-mail addresses are not case sensitive.

 Spaces are not allowed in e-mail address.

mailto:apcasgbn19@rediffmail.com


Components of E-mail Message 
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 E-mail message comprises of different components: E-mail Header, 
Greeting, Text, and Signature. 

 E-mail Header: The first five lines of an E-mail message is called E-mail 
header. 

 The header part comprises of following fields:

 From

 Date

 To

 Subject

 CC

 BCC
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 From: The From field indicates the sender’s address i.e. who sent the
e-mail.

 Date: The Date field indicates the date when the e-mail was sent.

 To: The To field indicates the recipient’s address i.e. to whom the e-
mail is sent.

 Subject: The Subject field indicates the purpose of e-mail. It should
be precise and to the point.

 CC: CC stands for Carbon copy. It includes those recipient addresses
whom we want to keep informed but not exactly the intended
recipient.
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 BCC: BCC stands for Black Carbon Copy. It is used when we do not
want one or more of the recipients to know that someone else was
copied on the message.

 Greeting: Greeting is the opening of the actual message.

 Text: It represents the actual content of the message.

 Signature: This is the final part of an e-mail message. It includes
Name of Sender, Address, and Contact Number.

 Attachment: Ability to attach file(s) along with the message is one
of the most useful features of email. The attachment may be a word
document, PowerPoint presentation, audio/video files, or images. The
maximum size allowed is 25 MB.
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 Productivity tools: Email is usually packaged with a calendar,

address book, instant messaging, and more for convenience and

productivity.

 Access to web services: If you want to sign up for an account like

Facebook or order products from services like Amazon, you will need

an email address so you can be safely identified and contacted.

 Easy mail management: Email service providers have tools that allow

you to file, label, prioritize, find, group, and filter your emails for easy

management. You can even easily control spam, or junk email.
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 Privacy: Your email is delivered to your own personal and private

account with a password required to access and view emails.

 Communication with multiple people: You can send an email to

multiple people at once, giving you the option to include as few as

or as many people as you want in a conversation.

 Accessible anywhere at any time: You don’t have to be at home to

get your mail. You can access it from any computer or mobile device

that has an Internet connection.

 Reliable: Many of the mail systems notify the sender if e-mail

message was undeliverable.
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 Speed: E-mail is very fast. However, the speed also depends upon

the underlying network.

 Inexpensive: The cost of sending e-mail is very low.

 Printable: It is easy to obtain a hardcopy of an e-mail. Also an

electronic copy of an e-mail can also be saved for records.

 Global: E-mail can be sent and received by a person sitting across

the globe.

 Generality: It is also possible to send graphics, programs and sounds

with an e-mail.



Disadvantages
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 Apart from several benefits of E-mail, there also 
exists some disadvantages as discussed below:

 Forgery

 Overload

 Misdirection

 Junk

 No response
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 Forgery: E-mail doesn’t prevent from forgery, that is, someone
impersonating the sender, since sender is usually not authenticated in
any way.

 Overload: Convenience of E-mail may result in a flood of mail.

 Misdirection: It is possible that you may send e-mail to an
unintended recipient.

 Junk: Junk emails are undesirable and inappropriate emails. Junk
emails are sometimes referred to as spam.

 No Response: It may be frustrating when the recipient does not
read the e-mail and respond on a regular basis.



Web Development Tools
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 HTML

 JavaScript

 ASP.Net

 PHP

 CSS

 Microsoft Word
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 HTML: HTML Stands for Hypertext Markup Language. HTML is

the standard markup language for creating Web pages. HTML

describes the structure of a Web page. HTML consists of a

series of elements. HTML elements tell the browser how to

display the content.

 JavaScript is a text-based programming language used both

on the client-side and server-side that allows you to make web

pages interactive. Where HTML and CSS are languages that

give structure and style to web pages, JavaScript gives web

pages interactive elements that engage a user.
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 CSS: Stands for "Cascading Style Sheet." Cascading style sheets are used
to format the layout of Web pages. They can be used to define text styles,
table sizes, and other aspects of Web pages that previously could only be
defined in a page's HTML.

 ASP.NET is an open source, server-side web application framework created
by Microsoft that runs on Windows and was started in the early 2000s.
ASP.NET allows developers to create web applications, web services, and
dynamic content-driven websites.

 PHP is a recursive acronym for "PHP: Hypertext Preprocessor". PHP is a
server side scripting language that is embedded in HTML. It is used to
manage dynamic content, databases, session tracking, even build entire e-
commerce sites.
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 HTML stands for Hyper Text Markup Language, which is the most widely used

language on Web to develop web pages.

 HTML was created by Tim Berners-Lee in 1991.

 The first ever version of HTML was HTML 1.0, but the first standard version was

HTML 2.0, published in 1999.

 HTML is the combination of Hypertext and Markup language.

 Hypertext defines the link between the web pages.

 Markup language is used to define the text document within tag which defines

the structure of web pages.



HTML Verisons
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HTML Version Year

HTML 1.0 1991

HTML 2.0 1995

HTML 3.2 1997

HTML 4.01 1999

XHTML 2000

HTML 5 2014
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 Features of HTML:

 It is easy to learn and easy to use.

 It is platform independent.

 Images, video and audio can be added to a web page.

 Hypertext can be added to text.

 It is a markup language.

 Why learn HTML?

 It is a simple markup language. Its implementation is easy.

 It is used to create a website.

 Helps in developing fundamentals about web programming.

 Boost professional career.
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 Advantages:

 HTML is an easy to learn, easy to apply and it’s totally free you will just need a text
editor and a browser.

 It is supported by all browsers.

 It can be integrated with other languages like CSS, JavaScript etc.

 Disadvantages:

 HTML can only create static webpages. For dynamic webpages, other languages have to
be used.

 A large amount of code has to be written to create a simple web page.

 There is Lack of security in HTML.

 HTML language is not centralized i.e. all the web-pages that are connected, you have to
design them separately else need to use CSS.

 HTML become complex when you try to create a huge website.



HTML Tags
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 HTML tags are like keywords which defines that how web browser will format
and display the content.

 Tags are used to represent various elements of web page like Header, Footer,
Title, Images etc.,

 With the help of tags, a web browser can distinguish between an HTML content
and a simple content.

 When a web browser reads an HTML document, browser reads it from top to
bottom and left to right.

 HTML is made up of tags and its attributes. Tags are known as elements of
HTML. Additional information such as color, alignment etc., can be included with
an HTML tag is known as Attribute. Attributes are used to improve the
appearance of an HTML document.
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 All HTML tags must enclosed within < > these brackets.

 HTML tags are normally comes with pairs like <b> and </b>

 The first tag in a pair is the start tag, the second tag is the end tag.

 Start and end tags are also called as opening tags and closing tags.

 It is mandatory to include closing tags. If omitted, the browser applies the effect

of the opening tag until the end of page.

 Tags are of two types

 Paired or Container Tags

 Singular or Empty Tags
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 Paired tags or Container Tags:

 Paired tags require an opening tag that turns a formatting feature on
and a closing tag that turns the feature off.

 Paired tags must surround the text you want formatted with that feature.

 For example, <u> and </u> will underline text.

 Singular Tags or Empty Tags:

 Unpaired tags work alone, and are usually placed before the text you
want formatted.

 For Example, The <hr> which is used to draw horizontal line across the
width of the document and line break <br> tags are empty tags.



Structure of HTML
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 All HTML documents must begin with opening tag <html> and ending with

</html>.

 An HTML Document is mainly divided into two parts:

 HEAD: This contains the information about the HTML document. For Example,

Title of the page, version of HTML, Meta Data etc. This section begins with

<head> and ends with </head>. The <title>….. </title> is used to display

the title of the web page in browser window.

 BODY: This contains everything you want to display on the Web Page. The

Body Section begins with <body> and ends with </body> . Every content

enclosed within this tag will be shown on the web page, it maybe a text or

images or audios or videos or even links.
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Simple Webpage
409



Attributes
410

 Attributes are special words used inside a tag to specify additional information

to a tag.

 Attributes should be placed within the opening tag.

 Most of the tags support specialized attributes and there are also a few global

elements that can be used with any tag.

 Global elements are common to all HTML elements; they can be used on all

elements.



Attributes of <html> tag
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 The <html> tag is used to specify the beginning and closing
of an HTML document.

 This tag does not have any effect on appearance of
document.

 This is only used to make browsers and other programs,
known that this is an HTML document.

 <html> tag has two attributes viz. dir and lang to specify
the text direction and language setting respectively.
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Attributes of <body> tag
414

 The <body> tag defines the document’s body. The contents
of an HTML page reside within the <body> tag. <body>
tag contains several attributes.

(i) Background Color: bgcolor = color

 By default all the browsers display the text on white
background. However, the background color of the browser
can be changed by using bgcolor tag.

 The tag to change background colour:

<body bgcolor = color_name/color_code>
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 In the above HTML code, colour name has been used to change the
background color of the browser’s body section.

 Generally colors in HTML are represented as six digit hexadecimal values.

 Color name can be used for only few colors. But, color code (hexadecimal
value) will be more flexible to handle colors.

 The six digit hexadecimal value is the combinations of three, two digit
number sequence represent a color. First two digits represent Red, next two
digits for Green and last two digits for Blue (RGB) in the range of 00 – FF.

 For example, 000000 is black and FFFFFF is white. FF0000 is bright red.

 Modern browsers support nearly 140 colors.

 Color code should be prefixed with #.
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 The following table shows some basic colors with their hexadecimal code.

 To know the complete color code visit:

 https://www.w3schools.com/tags/ref_colornames.asp

https://www.w3schools.com/tags/ref_colornames.asp
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To change the background text Color
420

 Body text Colour: text = color

 The default text colour of body section is “black”, it is often called as automatic

color.

 The text attribute within body tag is used to change the text colour.

 The tag to change body text colour:

<body text = color_name/color_code>
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To change the Background Image
422

 Background image: background=image

 An image or picture can be applied as background to a webpage.
While inserting an image as background, the text will be displayed
on top of the image.

 Background images can be a texture or bitmap or even a photo.

 When you insert a small image, the browser takes the image and
repeats it across and down to fill browser window. Inserting
animated images (GIF images) creates more interesting.

 The tag to apply an image as background:

 <body background = “image_name_with_extenstion”>



423



424



425

 While including an image as background, the image file name is not required to be
in double quotes. The code <body background = flower01.gif> can also produce
the same result.

 If your image file name is long or split as two more words or along with path,
should be specify within double quotes.

 Remember that, if the image file and HTML source are located in different locations
i.e. in different folder or drive, file path should be clearly specified along with
image file name. In the above case, image file and HTML source file both are
located within the same folder. So, path name is not mentioned.

 For example, If the image file is somewhere in a folder (say Images folder in E:
drive), you must specify its full path within double quotes as given below.

 <body background = “E:\Images\ flower01.gif">



Setting Margin Values
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 Setting Margins: margin = value

 The margin refers the blank area from left, right, top edge or Bottom Edge
of the browser window.

 Generally there is no default margin setting in any browser. If you want to
leave some space as margin to left,right,top or bottom; leftmargin or
topmargin or rightmargin or bottommargin attributes will be used
respectively.

 The tag to specify the left, right, top and bottom margin:

 <body leftmargin = value topmargin = value rightmargin=value
bottom margin=value>

 The Value is referred as pixels (72 pixels to an inch)
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Headings
428

 Headings are used to include titles to sections of a web
page.

 HTML has six levels of headings viz. <h1> to <h6>.

 The number with h indicates the level of heading.
Header tags are display the body text as bolder and
larger in size according to its level.

 The syntax of heading tags:

 <h…> Heading text </h…>



HTML code with Headings
429



430



Attribute of Headings tag
431

 Align is an attribute to set right, center and justify alignment to headings. Left if

the default alignment, so that it is not supported in latest version of HTML. Justify

alignment is not supported by older browsers.

 The tag is to specify the alignment to headings:

<h# align = value>

 Where # is the level number, value may be Right, Center or Justify. Justify

alignment only used for paragraphs.
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Line Breaks and Paragraphs
434

 Browser applications are having some special rules for displaying
text.

 They do not recognize returns, tabs or even more than one space
between words.

 Usually, HTML document with multiple lines of text, browser will
display it as a single line.

 The <br> tag is used for line break.

 The <br> is an empty tag, does not have close tag and attribute.

 It should be placed at the end of a line
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Paragraph Tag
437

 In HTML, paragraphs are created using the <p> tag.

 The content what you type between <p> and </p> is identified as a

paragraph and display as a paragraph by the browser. Because, the browser

does not recognize returns (Pressing “Enter” Key).

 Remember that in word processors, pressing “Enter” key is identifying a

paragraph.



HTML Code to create a paragraph
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Browser with paragraphs
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Changing Paragraph alignment
440

 In HTML documents more are four paragraph alignments viz. Left, Right, Center

and Justify.

 The text that you type between <p> and </p> is by default aligned to left.

 To change the alignment of a paragraph align attribute can be used with <p>

tag.

 The tag to specify the alignment to paragraphs:

<p align = alignment>

 Where alignment can either be Right, Center or Justify.
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Comments
442

 Comments are used to describe the page or provide some kind of
indication of the status of the page.

 The tag <!> is used to create comments.

 In HTML, the text what you type within this tag is considered as
comments and it is ignored by the browser.

 Comments never show up onscreen.

 Comments can be placed anywhere in HTML document.

 The general form of comments:

<! comments >
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Text Formatting Tags of HTML
444

 Formatting text is very important as well as interesting task in creating web

pages.

 Formatting is purely based on the imagination and creativity of the programmer.

 Format the text such as making bold, italic, underline, changing font style, font

size, font color and more.

 <b>, <i>, <u> are the tags to make the text as bold, italic and underline.

These are all container tags.

 In addition to bold and italic tags, HTML provides <strong>, <em> tags to

make the text as bold and italics. These tags are container tags.
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 <strong> : Important text

 The <strong> tag is a phrase tag. It is used to define important text. This tag
displays the text as bold.

 <em> - Emphasized text

 The <em> tag is used to emphasize the text. That means, when you use this tag,
the text will be in italics.

 Visually these two tags display the contents as very similar as <b> and <i>
respectively. But, technically the meaning of <strong> and <em> is “Important”
not just bold and italics.

 The <big> tag is used to define the text bigger in size than the normal size. It
is often used to call attention a text.

 The <small> tag is used to define the text smaller than the current size.
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Usuage of Strong and em tag
448
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Usage of <big> and <small>
450
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Highlighting Text
452

 Highlighting is an important formatting feature is used to call attention to the

reader.

 The <mark> tag is used to highlight the text in HTML.

 This is also a container tag.

 Whatever the text given between <mark> and </mark> will be displayed as

highlighting with default color (mostly yellow).



Usage of <mark>
453
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Subscript and Superscript
455

 A Subscript is a way to display a character or a number below the normal line of type. For

example: The scientific notation for water is H2O. It should be written as H2O. Here, 2 is

appearing below the normal line. This is called Subscript.

 A Superscript is also a way to show a character or a number above the normal line of type. For

example: The familiar algebra equation “a plus b the whole square” should be written as

(a+b)2. Here, the square value 2 is appearing above the normal line. This is called Superscript.

 Usually, the subscript and the superscript character or number is smaller than the rest of the text.

 In HTML, the <sub> and <sup> tags are used to create subscript and superscripts respectively.

 As like as other formatting tags, this is also a container tag.

 The text or number given between <sub> and </sub> will be displayed as Subscript. Same as

subscript, the text or number given between <sup> and </sup> will be displayed as

Superscript.



Usage of <sub> and <sup>
456
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Inserting and Deleting
458

 <del> and <ins> tags are used to markup a segment of text as deleted
or inserted respectively. These two tags are container tags.

 The text what you specify between <del> and </del> will be displayed
as strike through.

 The text you specify between <ins> and </ins> will be shown as
underlined.

 To display a text as wrong text, the <s> tag can be used to show the text
as strike through style.

 The <s> and <del> tags are display the text in similar way. This is also a
container tag.

 The text you specify between <s> and </s> will be display in strike
through style.
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The Center Tag
461

 Paragraphs can be centered with Align attribute with <p>
tag.

 For non-paragraph text contents can be centered with
<center> tag.

 The <center> tag is used to centralize a segment of text.

 It is a container tag. That means, what you type between
<center> and </center> will be displayed in the center of
the browser.
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Changing font style, size and color
464

 The <font> tag is used to change the style, size and color of text.

 It is also a container tag.

 It is generally used for changing the appearance of a short segment of
text.

 A font is a named set of certain style of character and number. Each font
looks different from other fonts.

 Generally some fonts are used for specific purpose. For example, Times
New Roman is a style of font usually used for preparing office documents.
Arial is another font style which is used for publishing work. Variety of fonts
available in internet at free of cost.

 Generally, a browser shows the contents as default system font setting.
Every system has different font setting with another system.
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 The general form of <font> tag with attributes:

<font face= “font_name” size=value color=color_name / color_code>

Text to be displayed

</font>

 The face is an attribute to set different font style. The name of a font has multiple
words it should be specified within double quote.

 The size attribute is used to set size of the text. The size can have an absolute value
from 1 to 7. These predefined sizes are known as virtual size. Each virtual size is
successively 20% larger than the previous one.

 The color attribute is used to set the color to the text. As you leant earlier color
name or color code in hexadecimal may be used.
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Multiple fonts with face attribute:
468

 As discussed earlier, the face attribute of font tag is used to change font 
style of a segment of text. In face attribute, it is possible assign more than 
one font-name at a time within double quotes with comma. 

 For example,

<font face = "Bookman old style1, Broadway1, Forte, Arial">

Welcome to HTML

</font>

 Browser first tries to find out whether the font-name in the list is supported 
or not. If the first font is not supported by the browser, then it displays the 
text in second font, otherwise it will display next one. If no font in the list is 
supported, then the browser display the in the default font.
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 In the above code, consider the font names “Bookman old style1” and

“Broadway1” are not supported by any browser. (Because, the names has been

changed).

 So, the text “Welcome to HTML” will be displayed in “Forte” style.

 If the browser does not supported “Forte” font, the text will be displayed in

“Arial” font, otherwise the browser shows the text as in default font setting.

 In the case of Internet explorer, the “Times New Roman” is the default font to

display the contents.



Section Break
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 The <hr> (Horizontal Rules) tag, which is known as “Thematic
Breaks” separate sections of an HTML document visually.

 It produces a horizontal line spread across the width of the browser.
This is an empty tag, which means the tag has no closing tag.

Attributes of <hr> tag

 The <hr> tag having four attributes viz. size, width, noshade and
color. These attributes are used to set size, width, 3D appearance
and color to the horizontal line respectively.

 The general syntax of <hr> tag with attributes:

 <hr size=value width=value noshade, color=color_name/code>



Size:
471

 Thickness of the horizontal line can be changed with size
attribute.

 The size is given in terms of pixels. A pixel is one of the tiny
dots that make up the display on computer.

 Generally, 72 pixels equal to an inch. Pixel is usually
referred as points.

 For example: The code <hr size = 72> display a horizontal
line with 1 inch thickness. The default size is 3 pixels.



Width:
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 The width attribute specifies the horizontal width of the rule line.

 The default rule is drawn across the full width of the browser.

 The value of the width attribute may be the exact width of the rule
in pixel or a certain percentage.

 Usually, the value of the width is specified as percentage. 100% is
the default width.

 For example:

 <hr width = 50%> display an half of a horizontal rule line on the
browser window.
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Noshade:

 The default view of a horizontal rule line is 3D. So, no need to
specify the term “noshade” as an attribute with <hr> tag.

 If you specify the attribute “noshade” turn off 3D view, turns on 2D
view. Noshade is a Boolean type attribute.

Color:

 The horizontal line is displayed in gray color by default.

 The color attribute is used to change is default color to desired color.
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Special Characters
476

 In HTML, special characters are typically those that can't be easily typed into a
keyboard or may cause display issues if typed or pasted into a web page.

 If you plan to use any of the special characters on this page, you should use either the
HTML entity name or the HTML entity number. This will ensure that it displays correctly in
most/all browsers.

 For example, if you want to display a copyright symbol "©", you should use either
&#169; or &copy; in your code.

 All the special characters must be ended with semicolon. (;)

 For Complete references of Special characters refer the following url:
https://dev.w3.org/html5/html-author/charref

 Following are some of the special characters.

https://dev.w3.org/html5/html-author/charref
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Character Entity Number Entity Name Description

" &#34; &quot; quotation mark

' &#39; &apos; apostrophe

& &#38; &amp; ampersand

< &#60; &lt; less-than

> &#62; &gt; greater-than

∀ &#8704; &forall; For All

∂ &#8706; &part; Partial Differential

∃ &#8707; &exist; There Exists

∅ &#8709; &empty; Empty Sets

∇ &#8711; &nabla; Nabla

∈ &#8712; &isin; Element Of

∉ &#8713; &notin; Not An Element Of

∋ &#8715; &ni; Contains As Member

∏ &#8719; &prod; N-ary Product

∑ &#8721; &sum; N-ary Summation



478

Character Entity Number Entity Name Description

Α &#913; &Alpha; Greek Capital Letter Alpha

Β &#914; &Beta; Greek Capital Letter Beta

Γ &#915; &Gamma; Greek Capital Letter Gamma

Δ &#916; &Delta; Greek Capital Letter Delta

Ε &#917; &Epsilon; Greek Capital Letter Epsilon

Ζ &#918; &Zeta; Greek Capital Letter Zeta

© &#169; &copy; Copyright Sign

® &#174; &reg; Registered Sign

€ &#8364; &euro; Euro Sign

™ &#8482; &trade; Trademark

← &#8592; &larr; Leftwards Arrow

↑ &#8593; &uarr; Upwards Arrow

→ &#8594; &rarr; Rightwards Arrow

↓ &#8595; &darr; Downwards Arrow

♠ &#9824; &spades; Black Spade Suit

♣ &#9827; &clubs; Black Club Suit

♥ &#9829; &hearts; Black Heart Suit

♦ &#9830; &diams; Black Diamond Suit
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Character Entity Number Entity Name Description

« &#171; &laquo; angle quotation mark (left)

¬ &#172; &not; negation

&#173; &shy; soft hyphen

¯ &#175; &macr; spacing macron

° &#176; &deg; degree

± &#177; &plusmn; plus-or-minus

² &#178; &sup2; superscript 2

³ &#179; &sup3; superscript 3

´ &#180; &acute; spacing acute

µ &#181; &micro; micro

¶ &#182; &para; paragraph

· &#183; &middot; middle dot

¸ &#184; &cedil; spacing cedilla

¹ &#185; &sup1; superscript 1

º &#186; &ordm; masculine ordinal indicator

» &#187; &raquo; angle quotation mark (right)
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Character Entity Number Entity Name Description

¼ &#188; &frac14; fraction 1/4

½ &#189; &frac12; fraction 1/2

¾ &#190; &frac34; fraction 3/4

¿ &#191; &iquest; inverted question mark

× &#215; &times; multiplication

÷ &#247; &divide; Division

&#160; &nbsp; non-breaking space

¡ &#161; &iexcl; inverted exclamation mark

¢ &#162; &cent; cent

£ &#163; &pound; pound

¤ &#164; &curren; currency

¥ &#165; &yen; yen

¦ &#166; &brvbar; broken vertical bar

§ &#167; &sect; section

¨ &#168; &uml; spacing diaeresis
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Tables in HTML
482

 Table is grid of rows and columns. 

 The tables were officially introduced with HTML 3.2. 

 Tables are useful for the general display of tabular data. Representing table in HTML 
is heavy on tags.

 Tags to create table elements

 There are five core tags are used to create a table in HTML. They are,

 <table> tag is used to create a table.

 <tr> tag defines table rows

 <th> tag defined table columns

 <td> tag is used to specify the data in a cell

 <caption> tag defines title for the table

 Apart from these five core tags, <tbody>, <thead> and <tfoot> tags are also used 
to define and control whole sections of table. All the above tags are container tags.
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Creating Table
484

 In the above HTML code, the <Table border=1> tag creates a table structure with
border.

 The code <Caption> Books and Authors </Caption> display the text specified
between <Caption> as title to the table.

 The above code contains four set of <tr> blocks. First block of <tr> creates a table
row with three column headings with the help of <th> tag.

 The <th> tag is used as Table heading, the column heading were aligned center
and text becomes bold by default.

 Rest of the <tr> blocks display the contents what you specify within <td> tags.

 All the tags used with table were container tags. So, each and every tag should be
closed with their closing tag.
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Attributes of Table
487

The <table> is a container tag. There are several attributes to improve the layout of the table.
They are listed below:

 Cellspacing: It is used to set the space between cells in a table. The value should be in pixels

 Cellpadding: It is used to set the space between the contents of a cell and its border. the value
should be in pixels.

 Border: Border attribute with <table> tag is used to specify the thickness of the border lines
around the table. The value of the border attribute should be a non zero value in pixels. If its
value is zero, HTML displays the table without border.

 Bordercolor: It is used to apply the color to the border lines.

 Align: It is used to set the position of the table within the browser window. Left is the default
position. Right or center may be the value of align attribute.

 Bgcolor: It is used to apply background colour to the table.

 Height and Width: These two attributes are used to specify the height and width of a table in
terms of pixels or percentage.
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Attributes of <TD>, <TH> and <TR> tags:
490

 Align: Used to specify the horizontal alignment of content within a cell. Left is the 

default alignment. Possible values are Right and Center.

 VAlign: Used to specify the vertical alignment of the contents within a cell. Bottom is 

the default alignment. Possible values are Top and Middle

 Width: Used to specify the width of a cell in terms of pixels or percentage.

 Bgcolor attribute is used to apply a particular colour to the background of a cell.

 Background attribute is used to apply an image or picture as background of a cell.

 Rowspan attribute is used to merge two or more cells in a row as a single cell.

 Colspan attribute is used to merge to two or more cells in a column as a single cell.
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Lists in HTML
494

 HTML supports three types of lists viz. Numbered, Unnumbered and
Definition.

 These lists are called as Ordered List, Unordered List and Definition
List respectively.

Numbered List / Ordered List

 Numbered list is created within the tag pair <OL> ….. </OL> tag.

 The tag <LI> is used to present the list item in the list.

 Ordered list displays items in a numerical or alphabetical order.
Both <OL> and <LI> tags are container tags.
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Attributes of Ordered List:
497

 There are two attributes can be used to customize ordered list, they
are

 Type - changing numbering style

 Start - changing numbering order.

 Type – is used to change the number style. The default number style
is standard Arabic numerals (1,2,3,…………).

 Start – is used to specify the number of letter with which start the
list. The default starting point is 1. The value of the start attribute
should be a decimal number, regardless of the numbering style
being used.
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Un-numbered List / Unordered List
501

 Unordered lists are often referred as bulleted lists.

 Instead of numbers, each element in the list has prefixed with a special bullet

symbol.

 Unordered list is surrounded within <UL> ……… </UL> tags.

 As discussed earlier, each list element is defined by <LI> tag.

 Attribute of Unordered List: Like ordered list, type attribute is used to customize

bullet style for the list of elements. By default, a solid circle is used as bullets.
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Definition List
505

 Definition list is different from other two types of list. No bullet or
number is provided for the list items. In this list type, the list element
has two parts.

 A definition term

 The definition description

 Definition list is surrounded within <DL> ……. </DL> tags.

 Definition term is presented in between <DT> ….. </DT> tag and

 Definition description should be surrounded within <DD> …………
</DD> tag.
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Nested Lists
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Links:
510

 Link is an important feature of HTML to connect web resources.

 Link in HTML is used to create hyperlinks to web content.

 Web content may be an HTML document or an external webpage or any
multimedia content such as an image, video, audio, animation etc., or even a
part of the current document.

 There are two important things needs to create a link in HTML,

 The name of the file or URL to which you want to link

 The text that will serve as the clickable link.

 The anchor tag <A> is used to create links along with HREF attribute. HREF
is abbreviated as “Hypertext Reference”.

 Structure of an anchor tag with href:

 <A href = “ Web content path / URL “> Text – Clickable link </A>
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 The above link code creates the target of the hyperlink to the website

 https://www.apcas.in. At the time the user clicks the link, the browser opens the

home page of the URL.

https://www.apcas.in/
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 Internal Links:

 Creating a link to a particular section of the same document is known as Internal
Link.

 To create an internal like, the attribute Name is used along with <A> tag.

 The Name attribute of <A> tag establish the link to the content within the
document.

 External Link:

 Establish link with an external web page in known as external linking.

 It is made possible by providing the URL of the external file in the HREF
attribute of <A> tag of the current page.
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Inserting Images
516

 Images are essential element to make an HTML presentation as more attractive

manner.

 Moreover images are used to depict many complex concepts in simple way.

 To make more attractive and communicative web pages, images should be

added in the appropriate places.

 Images displayed on the web page should be converted to universally

supported format.

 Most of the browsers supports, GIF, JPEG and PNG images formats. HTML-5

introduces SVG images.



Inserting Images with HTML document
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 The <IMG> tag along with the attribute src (Source) is used to add images in HTML document.

 General format:

<img src = image_name_with_extension>

(OR)

<img src = URL>

 Example:

<img src = image1.gif>

 Src attribute is the main attribute used to specify the file name of the image to be inserted. If
the image is not in the current working folder, the image file name should clearly specify with
the path of the file or URL, where the file is available.

 Example:

<img src = “D:\images\animals\cat.jpeg”>
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Other Attributes of <img> tag:
520

 Other than src, the <img> tag has many attributes the enable to control how the
image is presented on the page.

 Alt (Alternative Text): The alt attribute within <img> tag is used to describe the
image, so that some text is conveyed even when the image cannot be displayed.

Example: <img src = bharathiyar.gif alt = “National Poet of India”>

 Width and Height: Width and Height attributes are used to set the width and height
of an image. The values of these attributes should be either pixels or percentage of
its actual size. If these attributes are not specified, the browser displays the image
in its original size.

 Vspace (Vertical Space) and Hspace (Horizontal Space): Vspace and Hspace
attributes are used to set Vertical and Horizontal space between the images.
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 Align: The align attribute used to aligns the image with
respect to the base line of the text. This attribute has the
following values.

 Bottom – Aligns the bottom of the image with the baseline of the
text. This is the default setting.

 Middle – Aligns the middle of the image with the baseline of the
text.

 Top – Aligns the top of the image with the baseline of the text.

 Left and Right values of Align attribute:

 Using left and right values with align attribute, displayed the
image on the left and right side of the text.
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Scrolling text using <Marquee>
525

 In HTML, a piece of text or image can be moved horizontally or vertically by using
<marquee> tag. This feature makes a web page as more attractive.

General format: <marquee> Text or image to be scroll </marquee>

Attributes of <marquee>

 Height and Width: These attributes are used to set height and width of the
marquee. The values should be either in pixels or in percentage of browser window.

 Direction: This is used to specify the direction of the movement of text or image. The
text or image will move towards right to left by default. So, the default direction is
left. The Possible values are ‘up’, ‘down’, ‘left’ or ‘right’.

 Behaviour: This attribute is used to specify the type of scrolling. The values are
‘scroll’, ‘slide’ and ‘alternate’.

 Scrolldelay: This attribute is used to define the time delay between each jump. The
time unit should be in seconds.
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 Scrollamount: This is used to define the speed of the scroll.

 Loop: This is for defining how many times the marquee element should repeat on

the screen. The default value is ‘infinite’, which means the marquee element

scrolls endlessly.

 Bgcolor: This is used to specify the background color to the marquee elements.

 Hspace and Vspace: This is for defining the horizontal and vertical space

around the marquee. The value can be in pixels or percentage.
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FRAMES
528

 HTML frames are used to divide your browser window into multiple sections
where each section can load a separate HTML document.

 A collection of frames in the browser window is known as a frameset.

 The window is divided into frames in a similar way the tables are
organized: into rows and columns.

 Frames are used to show one or more html documents in a one window.

 Present documents in multiple views.

 To use frames on a page we use <frameset> tag instead of <body> tag.

 The <frameset> tag defines, how to divide the window into frames.

 The rows attribute of <frameset> tag defines horizontal frames and cols
attribute defines vertical frames. Each frame is indicated by <frame> tag
and it defines which HTML document shall open into the frame.
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Attribute Value Description

frameborder
1. (No)

2. (Yes)
Specifies whether or not to display a border around a frame

longdesc URL Specifies a page that contains a long description of the content of a frame eg: longdesc = "framedescription.htm"

marginheight pixels Specifies the height of the space between the top and bottom of the frame's borders and its contents.

marginwidth pixels Specifies the width of the space between the left and right of the frame's borders and the frame's content.

name text Specifies the name of a frame

noresize noresize Specifies that a frame is not resizable

scrolling Yes, no, auto Specifies whether or not to display scrollbars in a frame

src URL Specifies the URL of the document to show in a frame
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Information.
535

 Information can be defined as meaningfully interpreted data. If we give you a
number 1-212-290-4700, it does not make any sense on its own. It is just a raw
data. However if we say Tel: +1-212-290-4700, it starts making sense. It becomes
a telephone number. So, from a system analyst's point of view, information is a
sequence of symbols that can be constructed to a useful message.

 Information could be classified on the basis of the purpose for which it is utilized,
into three main categories:

 Strategic Information: it is required by the managers at the strategic level of
management for the formulation of organizational strategies.

 Tactical Information : information in this category is used in short term planning and is of
use at management control level.

 Operational Information: it applies to short periods which may vary from an hour to a
few days.
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 An Information System is a system that gathers data and distributes information with the sole purpose

of providing information to its users. The main object of an information system is to provide information

to its users. Information systems vary according to the type of users who use the system.

 A Management Information System is an information system that evaluates, analyzes, and processes

an organization's data to produce meaningful and useful information based on which the management

can take right decisions to ensure future growth of the organization.

 Information system, an integrated set of components for collecting, storing, and processing data and

for providing information, knowledge, and digital products.

 Business firms and other organizations rely on information systems to carry out and manage their

operations, interact with their customers and suppliers, and compete in the marketplace.

 Information systems are used to run interorganizational supply chains and electronic markets. For

instance, corporations use information systems to process financial accounts, to manage their human

resources, and to reach their potential customers with online promotions.
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 Many major companies are built entirely around information systems.

 These include eBay, a largely auction marketplace;

 Amazon, an expanding electronic mall and provider of cloud computing services;

 Alibaba, a business-to-business e-marketplace; and

 Google, a search engine company that derives most of its revenue from keyword

advertising on Internet searches.

 Governments deploy information systems to provide services cost-effectively to citizens.

 Digital goods—such as electronic books, video products, and software—and online

services, such as gaming and social networking, are delivered with information systems.

 Individuals rely on information systems, generally Internet-based, for conducting much

of their personal lives: for socializing, study, shopping, banking, and entertainment.



Functions of Information Systems
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 One of the mostly widely used bases for organizing activities in almost every
organization is the business function.

 Business activities are grouped around functions such as production, marketing,
finance and personnel etc.

 Resulting in the respective department or an area of the business organization.

 These departments or functional areas are commonly known as the functional areas
of business.

 There is no standard classification of such sub-system in an organization, but a
typical set of functions in a manufacturing organization includes:

 Production

 Marketing

 Finance and accounting

 Materials and Personnel systems



540

 Production: 

 Production planning and control 

 Engineering standards 

 Quality control 

 R & D etc

 Finance and Accounting:

 Financial planning 

 Budgeting 

 Cost accounting 

 Asset accounting 

 Accounts receivable 

 Payroll 

 Accounts payable, etc...
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 Marketing: 

 Sales order 

 Forecasting 

 Sales analysis 

 Billing 

 Distribution 

 Stock availability 

 Sales quota control 

 Pricing 

 Product promotion
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 Materials: 

 Material planning 

 Bill of material 

 Cost estimate 

 Warehousing planning etc...

 Personnel: 

 Employee recruitment 

 Employee selection 

 Employee development 

 Employee transfers 

 Employee retirements etc...



Components of Information Systems
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 The main components of information systems are

 Computer Hardware

 Software,

 Telecommunications,

 Databases and data warehouses,

 Human resources, and Procedures.

 The Hardware, Software, and Telecommunications constitute
information technology (IT), which is now ingrained in the
operations and management of organizations.
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 Telecommunications: Telecommunications are used to
connect, or network, computer systems and portable
and wearable devices and to transmit information.
Connections are established via wired or wireless
media. Wired technologies include coaxial cable and
fiber optics. Wireless technologies, predominantly
based on the transmission of microwaves and radio
waves, support mobile computing.



Databases and Data warehouses
545

 A Database is a collection of interrelated data organized so that individual
records or groups of records can be retrieved to satisfy various criteria.
Typical examples of databases include employee records and product
catalogs. Databases support the operations and management functions of
an enterprise.

 Data warehouses contain the archival data, collected over time, that can
be mined for information in order to develop and market new products,
serve the existing customers better, or reach out to potential new customers.

 Massive collection and processing of the quantitative, or structured, data, as
well as of the textual data often gathered on the Web, has developed into
a broad initiative known as “Big data.” Many benefits can arise from
decisions based on the facts reflected by big data.



Human Resources and Procedures
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 Qualified people are a vital component of any information system. Technical personnel

include Development and Operations Managers, Business Analysts, Systems Analysts

And Designers, Database Administrators, Programmers, Computer Security Specialists,

And Computer Operators.

 In addition, all workers in an organization must be trained to utilize the capabilities of

information systems as fully as possible. Billions of people around the world are

learning about information systems as they use the Web.

 Procedures for using, operating, and maintaining an information system are part of its

documentation. For example, procedures need to be established to run a payroll

program, including when to run it, who is authorized to run it, and who has access to

the output. In the autonomous computing initiative, data centers are increasingly run

automatically, with the procedures embedded in the software that controls those

centers.



Types of Information Systems
547

 Information systems support operations, knowledge work, and
management in organizations.

 Information systems that support a specific organizational function,
such as marketing or production, have been replaced in many cases
by cross-functional systems built to support complete business
processes, such as order processing or employee management.

 Such systems can be more effective in the development and delivery
of the firm’s products and can be evaluated more closely with
respect to the business outcomes.
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 Information systems consist of three layers:

 Operational support,

 Support of knowledge work, and

 Management support.

 Operational Support forms the base of an information system and contains
various transaction processing systems for designing, marketing, producing,
and delivering products and services.

 Support of Knowledge work forms the middle layer; it contains subsystems
for sharing information within an organization.

 Management Support, forming the top layer, contains subsystems for
managing and evaluating an organization's resources and goals.



Classification of Information System
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 The discipline of MIS is in its evolutionary stage. MIS is a concept,
which is a matter of degree rather than an absolute one.

 The classifications of information system are

 Transaction Processing System.

 Management Information System.

 Decision Support System.

 Executive Support System.

 Office Automation System.

 Business Expert System.



Transaction Processing System
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 It represents the automation of the fundamental, routine process used to support

business operations.

 It does not provide any information to the user for his/her decision making.

 Previously Transaction processing system was known as MIS.

 Prior to computers, data processing was performed manually or with simple

machines.

(INPUT) DATA→PROCESSING→DATA (OUTPUT)



Management Information System
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 MIS is an information system which process data and converts it into information.

 A MIS uses TPS for its data inputs.

 The information generated by the information system may be used for control of
operations, strategic and long range planning, short range planning,
management control and other managerial problem solving.

 It has some functional business areas. They are

 Marketing

 Production

 Human resources

 Finance Accounting etc...

 TPS→DATA→INPUT→PROCESSING→OUTPUT→INFORMATION



Decision Support System
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 The Decision support system (DSS) is an information system application that
assist decision making.

 Decision support systems tend to be designed primarily to serve
management control level and strategic planning level managers.

 The data in the database typically is a combination of master files (internal
corporate data) and from external sources.

 Database←-------------→model base

↘user interface↙

↕

User



Executive Support System:
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 Executive Support System (ESS) is an extension of the management information

system which is a special kind of DSS.

 An ESS is specially tailored for the use of chief executive of an organization to

support his decision making.

 An ESS is designed to provide the information needs of a chief executive

keeping in view not only his requirements but also taking into account his

personality and style of functioning etc.,



Office Automation System
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 Office automation refers to the application of computer and communication
technology to office functions.

 Office automation systems are meant to improve the productivity of managers at
various level of management by providing secretarial assistance and better
communication facilities.

 Office automation systems are the combination of hardware, software and people
in information systems, that process office transactions and support office activities
at all levels of the organization.

 These systems include a wide range of support facilities, which include Word
Processing, Electronic Filing, Electronic Mail, Message Switching, Data Storage, Data
And Voice Communication etc...

 In the first category, the following is a list of activities. Typing, Mailing, Scheduling
of meetings and conferences, Calendar keeping and Retrieving documents

 In the secondary category, Conferencing, Production of Information, Controlling
Performance.



Business Expert System
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 Business expert system (BES) is a knowledge based information system that
uses its knowledge about a specific, complex application area to act as an
expert.

 This system is one of the Knowledge Based Information System.

 Expert system provides decision support to managers in the form of advice
from an expert in a specific problem area.

 Expert systems find application in diverse areas, ranging from medical,
engineering and business.

 Knowledge base←-------------→inference engine

↘user interface↙



Management Concepts
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 Every business unit has some objectives of its own. These objectives can be

achieved with the coordinated efforts of personnel. The works of a number of

persons are properly coordinated to achieve the objectives through the process

of management.

 Management is a vital aspect of the economic life of man, which is an organized

group activity. It is considered an indispensable institution in the modern social

organization marked by scientific thought and technological innovations.

 One of the other forms of management is essential wherever human efforts are

to be undertaken collectively to satisfy wants through some productive activity,

occupation, or profession.
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 It is management that regulates man's productive activities through the coordinated

use of material resources. Without the leadership provided by management, the

resources of production remain resources and never become production.

 Management is the integrating force in all organized activity. Whenever two or

more people work together, to attain a common objective, they have to coordinate

their activities. They also have to organize and utilize their resources in such a way

as to optimize the results.

 Management is usually defined as planning, directing, and controlling business

operations. Management is the process of allocating an organization's input

including human and economic resources by planning, organizing, directing, and

controlling for the purpose of producing goods or services desired by customers so

that organizational objectives are accomplished.



Functions of Management
559

 Management has been defined as a process of getting things done through

others. This process is identified in a set of functions performed by managers to

accomplish the goals. A manager is thus someone who defines, plans, guides,

helps out, and assesses the work of others, frequently people for whom the

manager is accountable in an organization.

 The following mentioned management functions will involve creative problem

solving.

 Planning: According to Terry and Franklin, “planning is selecting information and

making assumptions concerning the future to put together the activities necessary

to achieve organizational objectives.” Planning includes both the broadest view

of the organization, e.g., its mission, and the narrowest, e.g., a tactic for

accomplishing a specific goal.
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 Organizing: Organizing is the classification and categorization of requisite

objectives, the grouping of activities needed to accomplish objectives, the

assignment of each grouping to a manager with the authority necessary to

supervise it, and the provisions for coordination horizontally and vertically in the

organization structure. The focus is on separation, coordination, and control of tasks

and the flow of information inside the organization. It is in this function that

managers allocate authority to job holders.

 Directing: Direction is telling people what to accomplish and seeing that they do it

to the finest of their capability. It includes making assignments, corresponding

procedures, seeing that mistakes are corrected, providing on the job instruction and,

of course, issuing orders.” The purpose of directing is to control the behavior of all

personnel to accomplish the organization's mission and objectives while

simultaneously helping them accomplish their own career objectives.
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 Staffing: The staffing function requires recognition of human resource needs,

filling the organizational structure, and keeping it filled with competent people.

This function includes recruiting, training; evaluating, and compensating are

specific activities.

 Controlling: “Control is the course of action that measures present performance

and guides it towards some predetermined goal. The quintessence of control lies

in checking existing actions against some desired results determined in the

planning process.”
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 According to the expert there are three types of level of management:

 Top Level Management

 Middle Level Management

 Low Level or Operative Management

Top Level Management

 Top level management consists of board of directors, managing directors or
executive committee members.

 Objectives of Top Level Management include the following.

 Setting key objectives, policies and identifying factors essential for the development of the
organization.

 Making appointments to the top position of the organization such as managers
department heads etc.

 Reviewing the work of different personnel in various levels.



Middle Level Management
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 Middle level management consists of managers of various
departments such as productions, sales, marketing, resource, finance
etc.

Objectives of Middle Level Management include the following.

 Follow the rules and policies formulated by the top level management.

 Motivating personnel for higher productivity.

 Collecting detail analysis reports from the various departments.

 Mutual understanding with other departments in the organization.

 Recommendations to the top level management.



Low Level Management
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 Low level management consist of supervisors, daily workers etc. Follow the rules and guidelines
made out by the top level authentic of the organization.

 Some of the functions of Lower Level Management include the following.

 To issue orders and instructions to the workers and to supervise and control their work

 To classify and assign jobs to the workers

 To direct and guide the workers about work procedure

 To arrange for the necessary tools, equipment, materials etc., for the worker

 To solve the problems of workers

 To inform the management about the problems of workers which are not solved at this level?

 To maintain discipline among the workers and to develop in them the right approach to work.

 To maintain good human relations.

 To build a high group morale among the workers.



Management Information Systems
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 Management : Management covers the planning, control, and administration of the operations

of a concern. The top management handles planning; the middle management concentrates on

controlling; and the lower management is concerned with actual administration.

 Information: Information, in MIS, means the processed data that helps the management in

planning, controlling and operations. Data means all the facts arising out of the operations of

the concern. Data is processed i.e. recorded, summarized, compared and finally presented to

the management in the form of MIS report.

 System: Data is processed into information with the help of a system. A system is made up of

inputs, processing, output and feedback or control.

 Thus MIS means a system for processing data in order to give proper information to the

management for performing its functions.

 Definition: Management Information System or 'MIS' is a planned system of collecting, storing,

and disseminating data in the form of information needed to carry out the functions of

management.
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 The goals of an MIS are to implement the organizational structure and dynamics of
the enterprise for the purpose of managing the organization in a better way and
capturing the potential of the information system for competitive advantage.

 Following are the basic objectives of an MIS −

 Capturing Data − Capturing contextual data, or operational information that will
contribute in decision making from various internal and external sources of organization.

 Processing Data − The captured data is processed into information needed for planning,
organizing, coordinating, directing and controlling functionalities at strategic, tactical and
operational level. Processing data means −

◼ Making calculations with the data, Sorting data, Classifying data and Summarizing data

 Information Storage − Information or processed data need to be stored for future use.

 Information Retrieval − The system should be able to retrieve this information from the
storage as and when required by various users.

 Information Propagation − Information or the finished product of the MIS should be
circulated to its users periodically using the organizational network.
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 Following are the characteristics of an MIS −

 It should be based on a long-term planning.

 It should provide a complete view of the dynamics and the structure of the organization.

 It should be planned in a top-down way, as the decision makers or the management should
actively take part and provide clear direction at the development stage of the MIS.

 It should be based on need of strategic, operational and tactical information of managers of
an organization.

 It should also take care of exceptional situations by reporting such situations.

 It should be able to make forecasts and estimates, and generate advanced information, thus
providing a competitive advantage. Decision makers can take actions on the basis of such
predictions.

 It should create linkage between all sub-systems within the organization, so that the decision
makers can take the right decision based on an integrated view.

 It should allow easy flow of information through various sub-systems, thus avoiding
redundancy and duplicity of data. It should simplify the operations with as much
practicability as possible.



Characteristics of Computerized MIS
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 Following are the characteristics of a well-designed computerized MIS −

 It should be able to process data accurately and with high speed, using various techniques
like operations research, simulation, heuristics, etc.

 It should be able to collect, organize, manipulate, and update large amount of raw data
of both related and unrelated nature, coming from various internal and external sources
at different periods of time.

 It should provide real time information on ongoing events without any delay.

 It should support various output formats and follow latest rules and regulations in practice.

 It should provide organized and relevant information for all levels of management:
strategic, operational, and tactical.

 It should aim at extreme flexibility in data storage and retrieval.



The Role of Management Information Systems
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 Management Information System (MIS) has become very necessary due to the
emergence of high complexity in business organizations. It is all to know that without
information no Organization can take even one step properly regarding the decision-
making process. Because it is a matter of fact that in an organization decision plays an
essential role in the achievement of its objectives and we know that every decision is
based upon the information. If gathered information is irrelevant then the decision will
also incorrect and the organization may face big loss & lots of difficulties in surviving as
well.

 Two main roles are played by the decision making of the managers. First it helps the
managers to take decision based on the information being prepared. Second when the
decision making and decisions are fixed and only the input data change, it is as a
suitable repeating to support different types of manager’s decisions.
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 Helps in Decision making:- Management Information System (MIS) plays a

significant Role in Decision making Process of any Organization. Because in Any

organization decision is made on the basis of relevant information and relevant

information can only be Retrieving from the MIS.

 Helps in Coordination among the Department: - Management Information

System also helps in establishing a sound Relationship among every person of

the department to the department through proper exchanging of Information's.

 Helps in Finding out Problems: - MIS provides relevant information about

every aspect of activities. Hence, if any mistake is made by the management

then Management Information Systems (MIS) Information helps in Finding out the

solution to that problem.



571

 Helps in Comparison of Business Performance: - MIS store all Past Data and

information in its Database. That why management information system is very

useful to compare Business organization Performance. With the help of

Management information system (MIS) Organization can analyze his

Performance means whatever they do last year or Previous Years and whatever

business performance in this year and also measures organization Development

and Growth.



Planning for a Management Information System (MIS)
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 Below is a list of steps to follow when planning to adopt an MIS.

Define Outcomes

 Management information systems can help strengthen your organization, but there are

limited resources. Make a clear articulated case to secure funding and prioritize the effort.

 Identify tangible benefits that an MIS will bring to your organization

 Define the scope of the MIS (organizational level, regional level, country level)

 Develop measurements to assess whether MIS is successful.

Form your team

 The successful implementation of an MIS requires a combination of people and technology.

 Determine resources and skills needed for each of the three phases of an MIS (develop,

scale, and sustain)



Define what your system needs to do 
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Documenting system requirements and communicating them well is a crucial. Lack of understanding

between the users of a system and the people who design it is one of the main causes of frustration,

delays and cost overruns in IT projects.

 Conduct a self-inventory to map out what information systems and reporting relationships

already exist

 Establish common benchmarks, and harmonize reporting requirements

 Describe high-level business requirements and how key types of individuals (e.g. managers,

directors, auditors, donors) will use the MIS data.

 Determine technical requirements for your specific context. E.g., if electricity and/or Internet

connectivity is a problem in your context, plan for:

 Offline data entry

 Automatic transmission of data to a central database when communication networks are available

 Identify how newly computerized processes link to retained manual and paper-based processes



Find the right solution 
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 There is a range of potential solutions depending on your resources and needs. This
includes buying or building your system, selecting open-source or proprietary
systems.

 Identify the best system for your organization depending on your resources and
expected use. Software models can range from custom-developed software (i.e.
build a software system from scratch) to Software as a service (SaaS) (i.e. a
database and application hosted on remote servers, and software is sold (or
offered freely) as a service that can be contracted per user and per month or
year).

 SaaS applications are particularly useful because they:

 Eliminate need to invest in local servers

 Eliminate need for in-house IT staff o Incorporate on-demand training and support

 Often incorporate a pay by the drink cost model (obviate large up front investments)

 Easier to transfer to local institutions



Estimate implementation and operating costs 
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 Estimate project cost for pilot, scale up, and maintenance

 Pilot: the functional, technical, and organizational complexity of the project
drives costs. Costs do not vary significantly for a large or a small country.

 Scale: the number of future users and the cost per user to deploy it are the
most important variables. The cost per user depends on the way in which
users will access the system (for example, desktop computer, mobile phone,
paper) and their training needs.

 Sustain: Apart from the number of users, the selected technology is critical
here. For example, any solution that requires local software installation and
maintenance will be more expensive than a centralized system, such as a
web-based or cloud system.



576

 Create an implementation plan

 Define work plan for development, pilot. and scale up.

 Don’t forget to include training of MIS users.

 Track milestones

 Understand and manage project risks

 The seven steps above should lower project risk by aligning requirements to organizational objectives,
understanding costs, planning appropriately, and choosing the right vendors. In addition, consider the
following type of risks below.

 Lack of governance: Many cite lack of leadership buy-in as the most important factor for project failure.

 Poor management: The management team lacks the technical capacity or the organizational authority to provide the
project the stability it needs.

 Development risk: Relates to changing user requirements and a misunderstanding of the technology that is being used.

 Deployment risk: Systems from a failure to manage the changes that will affect the organization because of the new
information system.

 Operational risk: Arises when the organization is not ready to support newly introduced technologies over the longer
term.



Control Issues in Management Information Systems.
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 Control is the process through which manager assures that actual activities are according
to standards leading to achieving of common goals.

 The control process consists of measurement of progress, achieving of common goals and
detects the deviations if any in time and takes corrective action before things go beyond
control.

 Information systems operate in real world situations which are always changing and
there are lots of problems. Information systems are vulnerable to various threats and
abuses.

 Security Control

 The resources of information systems like hardware, software, and data, need to be
protected preferably by build in control to assure their quality and security.
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 Types of Security Control:

 Administrative control

 Information systems control

 Procedural control

 Physical facility control

 Administrative Control

 Systems analysts are actually responsible for designing and implementing but these people need the
help of the top management in executing the control measure. Top executives provide leadership in
setting the control policy. Without their full support, the control system cannot achieve its goal.

 Information System Control

 Information system control assures the accuracy, validity and proprietary of information system
activities. Control must be there to ensure proper data entry processing techniques, storage methods
and information output. Accordingly management information system control are designed to see or
monitor and maintain quality, security of the input process, output and storage activities of an
information system.
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Input Control

 As we know whatever we give to computer the computer processes that and returns the result to us. Because of 

this very fact, there is a need to control the data entry process. The types of input control are:

 Transaction Codes: Before any transaction can be input into the system, a specific code should be assigned to it. This 

aids in its authorization.

 Forms: a source document or screen forms should be used to input data and such forms must adhere to certain rules.

 Verification: Source document prepared by one clerk can be verified by another clerk to improve accuracy.

 Control–totals: Data entry and other system activities are frequently monitored by the use of control-total. For example, 

record count is a control-total that consist of counting the total number of source documents or other input records and 

compare them at other stage of data entry. If totals do not match, then a mistake is indicated.

 Check digit: These are used for checking important codes such as customer number to verify the correctness.

 Labels: It contains data such as file name, and date of creation so that a check can be made that correct file is used for 

processing.

 Character and field checking: Characters are checked for proper mode – numeric, alphabetic, alphanumeric fields – to 

see if they are filled in properly.
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Processing Control

 Input and processing data are so interrelated that we can take them as first
line of defense. Once data is fed into the computer, controls are embedded
in various computer programs to help, detect not only input errors but also
processing errors. They are also used to ensure that data are not lost or do
not go unprocessed.

Output Control

 These are developed to ensure that processed information is correct,
complete and is transmitted to authorized user in a timely manner. The
output control are mostly of same kind as input control e.g. Output
documents and reports are thoroughly and visually verified by computer
personnel and they are properly logged and identified with rout slips
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Storage Control

 Control responsibility of files of computer programs and databases is given to
librarian or database administrator. They are responsible for maintaining and
controlling access to the information. The databases and files are protected from
unauthorized users as accidental users. This can be achieved with the help of
security monitor. The method includes assigning the account code, password and
other identification codes. A list of authorized users is provided to computer system
with details such as type of information they are authorized to retrieve or receive
from it.

Procedural Control

 These methods provide maximum security to operation of the information system.
Standard procedures are developed and maintained manually and built in software
help display so that every one knows what to do. It promotes uniformity and
minimize the chance of error and fraud. It should be kept up-to-date so that correct
processing of each activity is made possible.
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Physical Facility Control

 Physical facility control is methods that protect physical facilities and their contents
from loss and destruction. Computer centers are prone to many hazards such as
accidents, thefts, fire, natural disasters, destructions etc. Therefore physical
safeguards and various control procedures are required to protect the hardware,
software and vital data resources of computer using organizations.

Physical Protection Control

 Many type of controlling techniques such as one in which only authorized personnel
are allowed to access to the computer center exist today. Such techniques include
identification badges of information services, electronic door locks, security alarm,
security policy, closed circuit TV and dust control etc., are installed to protect the
computer center.



Limitations of MIS
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 Even though MIS has many benefits it has its limitations. MIS is considered a solution for every
problem within an organization. While MIS may solve some critical problems but it is not a
solution to all problems of an organization.

 It cannot meet the special demands of each person. Mostly, the management information
system doesn’t provide exact information and the concept of a decision support system was
created in response to such need.

 The limitations of MIS may be stated as, The MIS is as good as its design- MIS if designed in
an improper manner does not serve the management and hence is of little relevance.

 The MIS is as good as its users-if the users do not know how to leverage the information
available from MIS then MIS is of little use.

 The MIS is no good if the basic data is obsolete and outdated (for example, MIS will only
facilitate garbage with information and in about garbage-out process)



The Challenges of Management Information Systems
584

 The major drawbacks and the reasons of failure and using MIS in public 
organizations are as following:

Humanistic factors

 The lack of information of the managers and users as they don’t know exactly 
what they want and what their information needs are.

 The lack of understanding of the needs of the users by designers (the lack of 
correct definition of the needs and their analysis)

 The lack of participation of the managers and users in system design.

 The lack of information of most of the analysts and programmers (designers) 
with new system work environment.

 The lack of acceptance of the system executers and resistance against the 
change.

 The lack of accuracy in the data collected



Organizational factors
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 The lack of good conditions for participation and collaboration of the managers, 
users and system directors

 The lack of consistency and complexity of the existing manual systems.

 The lack of existing systems and methods analysis before the system design

 The lack of evaluation of the existing power

 Bad condition of educating the specialized forces

 The lack of human resources with management and computer fields and other 
required specializations (the problems of absorbing human resources)

 Inadequate education of the users

 Inadequate and incomplete documentation

 Unsuitable implementation of the system



Decision Support Systems
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 Decision support systems (DSS) are interactive software-based systems intended

to help managers in decision-making by accessing large volumes of information

generated from various related information systems involved in organizational

business processes, such as office automation system, transaction processing

system, etc.

 DSS uses the summary information, exceptions, patterns, and trends using the

analytical models.

 A decision support system helps in decision-making but does not necessarily give

a decision itself.

 The decision makers compile useful information from raw data, documents,

personal knowledge, and/or business models to identify and solve problems and

make decisions.



Programmed and Non-programmed Decisions
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 There are two types of decisions - programmed and non-programmed decisions.

 Programmed decisions are basically automated processes, general routine work, where −

 These decisions have been taken several times.

 These decisions follow some guidelines or rules.

 For example, selecting a reorder level for inventories, is a programmed decision.

 Non-programmed decisions occur in unusual and non-addressed situations, so −

 It would be a new decision.

 There will not be any rules to follow.

 These decisions are made based on the available information.

 These decisions are based on the manger's discretion, instinct, perception and judgment.

 For example, investing in a new technology is a non-programmed decision.

 Decision support systems generally involve non-programmed decisions. Therefore, there will be
no exact report, content, or format for these systems. Reports are generated on the fly.



Attributes of a DSS
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 Adaptability and flexibility

 High level of Interactivity

 Ease of use

 Efficiency and effectiveness

 Complete control by decision-makers

 Ease of development

 Extendibility

 Support for modeling and analysis

 Support for data access

 Standalone, integrated, and Web-based



Characteristics of a DSS
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 Support for decision-makers in semi-structured and unstructured problems.

 Support for managers at various managerial levels, ranging from top
executive to line managers.

 Support for individuals and groups. Less structured problems often requires
the involvement of several individuals from different departments and
organization level.

 Support for interdependent or sequential decisions.

 Support for intelligence, design, choice, and implementation.

 Support for variety of decision processes and styles.

 DSSs are adaptive over time.



Benefits of DSS
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 Improves efficiency and speed of decision-making activities.

 Increases the control, competitiveness and capability of futuristic 
decision-making of the organization.

 Facilitates interpersonal communication.

 Encourages learning or training.

 Since it is mostly used in non-programmed decisions, it reveals new 
approaches and sets up new evidences for an unusual decision.

 Helps automate managerial processes.



Components of a DSS
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 Following are the components of the Decision Support System −

 Database Management System (DBMS) − To solve a problem the
necessary data may come from internal or external database. In an
organization, internal data are generated by a system such as TPS and
MIS. External data come from a variety of sources such as newspapers,
online data services, databases (financial, marketing, human resources).

 Model Management System − It stores and accesses models that
managers use to make decisions. Such models are used for designing
manufacturing facility, analyzing the financial health of an organization,
forecasting demand of a product or service, etc.

 Support Tools − Support tools like online help; pulls down menus, user
interfaces, graphical analysis, error correction mechanism, facilitates the
user interactions with the system.



Classification of DSS
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 There are several ways to classify DSS. Hoi Apple and Whinstone classifies DSS as follows −

 Text Oriented DSS − It contains textually represented information that could have a bearing on 
decision. It allows documents to be electronically created, revised and viewed as needed.

 Database Oriented DSS − Database plays a major role here; it contains organized and highly 
structured data.

 Spreadsheet Oriented DSS − It contains information in spread sheets that allows create, view, 
modify procedural knowledge and also instructs the system to execute self-contained 
instructions. The most popular tool is Excel and Lotus 1-2-3.

 Solver Oriented DSS − It is based on a solver, which is an algorithm or procedure written for 
performing certain calculations and particular program type.

 Rules Oriented DSS − Procedures are adopted in rules oriented DSS. Export system is the 
example.

 Compound DSS − It is built by using two or more of the five structures explained above.



Types of DSS
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 Following are some typical DSSs −

 Status Inquiry System − It helps in taking operational, management level, or middle level

management decisions, for example daily schedules of jobs to machines or machines to

operators.

 Data Analysis System − It needs comparative analysis and makes use of formula or an

algorithm, for example cash flow analysis, inventory analysis etc.

 Information Analysis System − In this system data is analyzed and the information report is

generated. For example, sales analysis, accounts receivable systems, market analysis etc.

 Accounting System − It keeps track of accounting and finance related information, for

example, final account, accounts receivables, accounts payables, etc. that keep track of the

major aspects of the business.

 Model Based System − Simulation models or optimization models used for decision-making are

used infrequently and creates general guidelines for operation or management.
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